
F Keys
F Keys are keyboard shortcuts  that perform tasks by using a combination
of keystrokes rather than using the mouse . For example, to eject a disk in
the disk drive , you can use the FKey combination Shift-Command-1. This
command  tells the disk drive to eject the disk. A popular F Key shortcut is
Shift-Command-3, which takes a screen shot (or screen capture) of whatever
currently is on your screen and saves it to your startup  disk as Picture 1 (if
there isn’t already a picture with that name). The screen capture can be
viewed in SimpleText , or it can be edited in most graphics program that can
open a PICT  image.

Shortcut Keys on the Mac

Key Standard Action

F1 Undo previous action

F2 Cut highlighted item

F3 Copy highlighted item to Clipboard

F4 Paste Clipboard item where cursor is

Shift-Command-1 Eject Disk

Shift-Command-3 Screen shot of open screen taken

Option-Command while starting Rebuild the desktop
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Command-N New Folder

Command-. Stop/Escape

Command-M Make Alias

Command-Y Eject Disk

Command-W Close Window

Contrary to popular belief, FKeys are not the keys that appear on the top of
an extended keyboard  as F1, F2, and so on. Those are called Function keys.
The first four keys have commands assigned to them: F1=Undo , F2=Cut ,
F3=Copy , and F4=Paste . The rest are blank and can be assigned keystrokes
with a program such as QuickKeys or any application, such as Adobe
Photoshop, that let's you assign function keys to commands from within the
application.

See Also
Command; Copy; Cut; Disk Drive; Eject; Extended Keyboard; Keyboard
Shortcuts; Mouse; Paste; PICT; Startup; SimpleText; Undo

F/A-18 Hornet
The graphics in F/A-18  Hornet are so complete in this new version, that
you can actually see blades of grass as you soar through the air. This best-
selling high tech military jet flight simulator offers twenty-eight missions
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of flight and multiple viewing options so you can set an arcade-ish or more
realistic cockpit view.

A big plus for F/A-18 is that it takes into account that not everyone is already
a flight sim pro and includes beginner settings so you can gradually take on
more responsibility as you play. F/A-18 comes fully equipped for combat with
a complex radar system, four air to air and two air to ground modes. The
Korean Crisis Theatre Set adds another twenty-eight missions with enhanced
terrain detail. Network  capabilities let you  dog-fight other players across a
modem  or online . F/A-18 also incorporates features such as mission replay
with multiple views, support for multiple monitors and the capability to set
the skill level of your enemy to better match your own.

See Also 
A-10 Attack!; Absolute Zero; Out of the Sun; Rebel Assault II; Sim Games; Wing
Commander III

FaceSpan
For all its power and flexibility, AppleScript  has one major failing: it has
no built-in support for creating scripts that have any more than a
rudimentary interface. FaceSpan, originally known as Frontmost, overcomes
this failing with a flourish.

FaceSpan is an interface builder  for AppleScripts. Using FaceSpan, you
can create AppleScript-based applications that feature a full Macintosh
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interface, including multiple windows, dialogs, menus, and more. You can
create your interface by “drawing” it in FaceSpan’s visual editor, and you
can attach scripts to interface elements.

Each interface element can include script handlers that are executed for user
interactions such as clicking, selecting, or pointing. The handler script can
manipulate other parts of the FaceSpan application, or interact directly with
another scriptable application. Adding support for Macintosh drag-and-drop
is a simple matter, as is adding customized Balloon Help.

Using this rich set of tools, you can create sophisticated applications that act
as custom interfaces to other applications or as a client interface for database
servers. FaceSpan is a great way for programmers to create quick application
prototypes to test user interface ideas.

FaceSpan projects can be saved as stand-alone applications that look and act
like applications written in C or Pascal. FaceSpan applications (as well as the
FaceSpan extension upon which they rely) can be redistributed royalty-free.

FaceSpan is published by:

Software Designs Unlimited
Email: facespan.sales@sdu.com
Fax: (919) 968-4576
Phone: (800) FACESPAN or (919) 968-7251
Web: http://www.sdu.com/

See Also
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AppleScript; Frontier; Interface Builder; Scripting

Fair Use
A legal doctrine by which courts can avoid rigid application of copyright law
when a work is reproduced for purposes of comment, criticism, news
reporting, teaching scholarship, or research. There is a lot of gray area, but
to decide whether it’s fair use, courts are likely to look at the purpose and
character of the use, the nature of the copyrighted work, the amount and
substantiality of the portion used, and the economic effect on the author. Fair
use is especially relevant to material published on the Internet , which can
be copied easily despite being protected by copyright  law.

See Also
Copyright; Intellectual Property; Internet

Family Entertainment
For the most part, when you get away from education /reference  software
and “edutainment ,” there isn’t much out there that appeals to kids and
parents alike. Titles like Day of the Tentacle and Sam and Max Hit the Road are
non-violent, but when it comes to game-play, they’re not something a
younger kid can really tackle without parental help. Just recently, a flock of
foreign titles including Great Britain’s Foul Play  and Japan’s Yellow
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Brick Road I & II  (see the following figure) have added to projects by
Philips Interactive and LucasArts’ attempts at non-violent, non-educational
entertainment that can actually appeal to children without forcing learning
down their throats.

One way to justify investing in a family computer has always been that you
could learn a lot. There is no question that the extensive resources on the
Internet and the multimedia reference titles available are a great reason to
get into computing, but who decided that only adults were allowed to play
games? The controversy over violence in games, whether or not you want
your children blowing things away and wading through dead bodies in
games like Blood Bath and Marathon , really comes from the fact that most
games aren’t geared for young audiences. LucasArts’ Mortimer (see the
following figure) and Philips’ Masterpiece Mansion operate on the principle
that kids learn by playing.

United States-based companies still seem to be integrating learning into their
games on the whole, but in a more fun fashion. However, games like Foul
Play and Yellow Brick Road II show that children’s title and family
entertainment can be fun without a heavy emphasis on education.

See Also 
Are You Afraid of the Dark?; Foul Play; Masterpiece Mansion; Mortimer;
Yellow Brick Road II
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FAQ
Acronym for Frequently Asked Questions, a ubiquitous feature on the
Internet , usually in file form. Used to present basic information about
virtually any topic, from software to newsgroups  to Web sites .

See Also
Internet; Newsgroups; Web Sites

Fax Capability in Modems
A modem’s capability to fax is a useful tool for desktop users and PowerBook
users staying in strange hotel rooms. Just how useful depends on the
modem—some fax modems can only send faxes, while others can send and
receive.

To completely replace a traditional paper fax machine, you’ll need a send-
and-receive fax modem and a scanner. You need the scanner to fax material
that doesn’t originate in electronic form, such as contracts, receipts, or maps.
You first have to scan the paper to get it in an electronic format before you
fax it, a two-step process. Because of this, a fax modem is not always superior
to a traditional fascimile machine.

However, there are some things that you can do with a fax modem that you
can’t do with a paper fax machine. For one, fax modems yield better quality
than do paper fax machines in both sending and receiving. In addition, some
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fax modems come with optical character recognition  (OCR) software,
which turns the pictures of characters of a received fax into editable text
(you can also buy OCR software). Because the quality of the received fax is
good, you’ll get fewer OCR errors by converting a fax received electronically
than with a paper fax that you have to scan.

The speed at which the modem can transmit faxes varies, but is usually
slower than the data speed. Fax modems that support the V.17 standard can
transmit faxes at 14,400Bps.

Sending a fax is as easy as printing with most fax software. To fax a document,
you usually hold down a key and pull down the File menu of an application.
In place of the usual Print command you’ll see a Fax command. Choosing it
invokes the fax software.

See Also
Modem

Fax Extension
This extension is part of Apple's GeoPort Express Modem Software and enables
you to send and receive faxes from Power Macs and AV Macs using Apple's
GeoPort feature. The GeoPort feature enables you, through a special adapter,
to connect a phone line to your Power Mac or AV Mac. The Fax extension
enables you to send and receive faxes through the built-in
telecommunications capabilities of your computer, without the use of an
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external modem.

See Also
Modems; AV Macs;

Fax Server
See
Server/Fax

Fiber Channel
See
Ports, Future Trends

File Assistant Extension
This extension, included with System 7.5 and higher, enables PowerBook
users to update files on their desktop Mac through a process called file
synchronization. By connecting your PowerBook to your desktop Mac, or
through a network connection, the File Assistant extension checks the files
on the desktop Mac, and, if the corresponding files on the PowerBook have
been updated, it updates the desktop Mac's files.
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See Also
Network; PowerBook

File, Determining Whether it Is Locked
To see if a file is locked  (meaning it can't be deleted or have its contents
edited) you can select the file and choose Get Info  (Command-I) from the
File menu to see if the "Locked” checkbox is checked, but there's a shortcut
that saves you a trip to the Get Info box. Click the name of the file (below the
icon). If the arrow pointer changes to the I-Beam cursor (enabling you to
enter a new name), it's unlocked. But if the arrow pointer stays, the file is
locked.

See Also
Get Info; Locked Files

File Formats
See
File Types, Internet

File Menu
The File menu, which appears at the desktop level  and as the first menu  in
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any application, enables you to open, close, save, and print documents, as
well as create new ones. The File menu also provides access to many
application-specific commands.

At the Desktop level, the File menu does the following:

• Provides access to the Get Info  window for any selected file
(Command-I)

• Enables you to invoke Sharing of files across a network

• Enables you to make duplicates of files (Command-D)

• Enables you to make aliases of files (Command-M)

• Provides access to the Put Away  (Command-Y) command for
ejecting disks  or putting recently moved files back in their original
location

The File menu at the desktop also contains the built-in Find file  (Command-
F) functions of the System,  as well as access to the Page Setup  and Print
dialog boxes .

Within an application, the File menu enables you to do the following:

• Create a new document

• Open or close a document

• Save a document
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• Use the Save As command on any document

• Use a variety of custom commands depending on the application

Printing dialog boxes appear under the File menu in applications. All
Macintosh applications list the Quit command as the last entry at the bottom
of the File menu.

See Also
Aliases; Desktop; Dialog Box; Duplicates; Ejecting Disks; Find File; Menu;
Network, Page Setup; Printing; Put Away; Sharing; System

File Server
See
Servers/File Server

File Sharing Extension
This extension is part of Apple's file sharing technology and is loaded into
the system at startup. The file sharing extension contains part of the code
used by the system for file sharing. If you're going to be using file sharing,
leave this extension in your System Folder.

See Also
Extensions; File Sharing; System Folder
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File Sharing Icon
If file sharing  is activated and your computer is shared on a network, the
shared folder  icon on your desktop  will have a small darkened tab added
to the top of the folder's icon with network cables attached to the folder. This
tells you that File Sharing is turned on.

See Also
Desktop; File Server; Network; Shared Folder; Sharing

File Sharing Monitor
When file sharing is active, you want to see who is connected to your
computer through the File Sharing Monitor Control Panel. When you open
the File Sharing Monitor, a window displays the users connected to your
computer in the right window and the items that are being shared under
Shared Items  in the left window. A bar graph below these windows shows
the amount of file sharing activity that goes from idle at the far left to busy
at the far right side of the graph. You can disconnect users from your system
from this control panel  and choose how much time elapses before they are
disconnected. When you type in a number, users accessing your computer
receive an on-screen dialog box warning them that they will be disconnected
soon. This gives them a chance to save changes  to their open documents. If
you want users disconnected immediately with no warning, type "0" in the
Minutes Till Disconnect dialog.
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To use the File Sharing Monitor Control Panel, follow these steps:

1. Choose the File Sharing Monitor from the Control Panels submenu on
the Apple menu (or System Folder).

2. A window displays a list of connected users and a list of shared folders
and disks.

3. You can disconnect users from your computer by clicking Disconnect
and entering the number of minutes before users are disconnected.
Users receive a disconnect warning, giving them a chance to save
their documents. If you enter "0," they will be disconnected
immediately.

See Also
Control Panel; File Sharing; Shared Items

File Transfer Protocols
The transfer of files between computers using modems is governed by File
Transfer Protocols. These protocols manage the actual transmission of the
files and reassembly at the remote end. They are normally used when you
upload (sending a file to a remote computer) or download (retrieve files from
a remote computer). Several different transfer protocols have evolved over
time. Each was designed to insure reliability and maximize transmission
speed for particular situation (see the following table).

F



TIP  The term file transfer protocols is used in a different sense
than the File Transfer Protocol (FTP) commonly referred to when
speaking of the Internet. The Internet’s FTP  refers specifically to
the UNIX-based File Transfer Protocol, which is part of the TCP/IP’s
set of network protocols.

The most basic style of transmission is called a "straight ASCII transfer" or a
“Blind Transfer". Essentially this tells the computer to use no protocol at
all—it sends files as straight ASCII  characters as fast as the hardware allows.
When transmitting in this fashion, the computer never stops to insure the
accuracy or completeness of incoming data. Thus, although fast, this protocol
isn’t of much use except for the transfer of small files.

More recent protocols have added features such as error correction, but do
potentially slow transmission over the theoretical maximum of a blind
transmission. Many protocols now support “batch transmission” which
allows you to specify multiple files to send and/or receive in advance of the
transmission.

The MacBinary  protocol is used when transferring Mac files to other
Macintosh users. This protocol makes sure that all of the Macintosh specific
information, such as Icons and resources, are kept intact. In nearly all file
transfers, you’ll make use of MacBinary. The only major exception is when
you’re sending files to DOS/Windows users. In this case, the extra
information can make the file unreadable on their machines.

TIP File transfer protocols are used in addition to any error
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correction protocols and hardware handshaking already negotiated
between the local and remote modem. More advanced protocols
such as Zmodem take this into account, and leave error correction
solely to the hardware, speeding the overall transfer by
preventing double checking of each piece of information.

If you are using an error correcting modem and the remote computer
supports it, Zmodem is the protocol of choice. Zmodem's capability to resume
interrupted transfers is extremely useful. In situations where Zmodem isn't
available, try Ymodem-G. If you don't have an error correcting modem, use
Ymodem or Xmodem-IK.

Generally the remote system will ask for your protocol preference before
beginning a file transfer. After telling the remote system what you'd like to
use, then it will then ask you to begin the transfer. At this point, your
computer will begin automatically (with Zmodem) or will issue a command to
tell your computer to begin (most other protocols).

Protocol Speeds

speed - error correction - notes

ASCII(“Blind Transfer”)

As Fast as the hardware allows - None - Text only.

XModem

Slow - Simple Checksum - Most widely used.
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XMODEM-IK

Medium - CRC - Sometimes called Ymodem.

YMODEM

Medium - CRC - Xmodem-IX with batch transfer.

Ymodem-G

Fast - none - Use only with error correcting modem.

ZMODEM

Fast - none - Use only with error correcting modem. Allows canceled
download to be restarted.

MacBinary

none - none - Used for Mac-Mac transfers to insure the Mac-specific
information is properly transferred.

See Also
FTP; Modem File Transfer Protocols

File Types, Internet
Users who download software from the Internet  from FTP  or other sites will
encounter a number of different file types that have been created by any
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number of different computers using a variety of software.

Each file type can be deduced from the three-letter extension at the end of its
filename. The most common on the Internet is the extension “.hqx,” which
denotes a file encoded with BinHex so that it can be transported easily across
the Net.

The following table lists common file type extensions, the software that was
used to create that particular file type, and the software needed to process it,
if necessary.

Common File Formats

Extension File Type Software to Process

.aiff Audio Interchange File Format Sound App, SoundMachine

.au Ulaw UlawPlay

.cpt Compact Pro Compact Pro, StuffIt
Expander

.dd DiskDoubler Disk Doubler, Expand Now

.gif CompuServe GIF Web browser, Giffer, JPEG
View

.hqx BinHex BinHex, StuffIt Expander

.jpeg Joint Photograhic Experts Group JPEG View, Web browser
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.mpeg Motion Picture Experts Group Sparkle

.pdf Adobe Acrobat Acrobat Reader

.ps PostScript GhostScript

.sea Self-Extracting Archive (double-click to launch
file)

.sit StuffIt StuffIt Expander

.txt Text

.uu uucode (UNIX) UULite, StuffIt Deluxe

.Z Compress (UNIX) MacCompress, StuffIt
Expander

.z, .gz Gzip (UNIX) MacGzip

.zip WinZip (Windows) Unzip, Zipit, StuffIt Deluxe

See Also
Acrobat, AIFF File, .AU File, Decoding/Decompressing files, Encoding Files,
File Transfer Protocol, GIF, Helper Applications, JPEG

File Is in Use Message
If you try to delete a file being used by the system or by an application by
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emptying the Trash, a message box alerts you that, "The file cannot be erased
because the file is in use." This protects your system and important
application files currently in use. If you want to delete the file, quit the
application, and the file can be deleted. System files on the startup disk, such
as the Finder file and System file, cannot be deleted and will display this
message. Also, any file that is open, such as a document open in an
application, cannot be deleted, and if you put the file in the Trash and choose
Empty Trash, you'll get the alert box stating, "The file cannot be erased
because the file is in use." This is to protect you from deleting important or
unsaved files.

To delete a file that is in use (besides Finder or System files on a startup disk),
you can close the open file and then delete the file by placing it in the Trash
and choosing Empty Trash.

See Also
Customizing; Extensions; Extensions Manager; QuickTime; Restart; Startup;
System 7

File Is Locked Message
If you try to delete a locked file by emptying the Trash , you get an alert
box  stating, "The Trash cannot be emptied because it contains items that are
locked ." Files are locked to keep them from being accidentally deleted. This
alert box tells you a locked file is in the Trash.
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If you want to delete a file in the Trash that is locked, you have two options:
you can hold the Option key while choosing Empty Trash from the Special
menu to delete the file, or you can open the Trash, select the file, and choose
Get Info from the File menu ( -I). In the Get Info window, uncheck the
option marked "Locked" in the lower-left corner (unlocking the file) and
close the Get Info window. You can then choose Empty Trash and the file will
be deleted.

See Also
Alert Box; Locking Files; Trash

Filename Extensions
A three-letter code at the end of a filename that indicates what sort of file it
is. Essential in non-Macintosh environments such as the Internet  where
client  software often lacks icons or other methods of identifying files. A
World Wide Web browser , for instance, can be set up to the recognize
filename extensions of files it encounters so that it can perform specific
actions on them, such as opening them with a helper application  or save
them to disk.

Some common filename extensions are listed in the following table.

Filename Extensions and File Types
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Extension File Type

Encoding Formats

.hqx BinHex 4.0 encoded document

.uu uucode

Compression Formats

.sit StuffIt compressed document

.cpt Compact Pro compressed document

.sea Self-extracting archive

.Z Compress (UNIX)

.tar tape archive (UNIX)

.dd DiskDoubler

.x SuperDisk

.pit PackIt

.zip PKZip (Windows, DOS)

.gz Gnu ZIP

Text Files

.txt ASCII text file
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.html HyperText Markup Language document

.rtf Rich Text Format file

.etx setext

Graphics Files

.gif Graphics Interchange Format

.jpeg Joint Photographic Experts Group

.eps Encapsulated PostScript

.tiff Tagged Interchange File Format

.pict PICT

.bmp bitmap (Windows)

Sound and Video Files

.au Ulaw (UNIX)

.aiff Audio Interchange File Format

.ra RealAudio

.mpeg Motion Picture Experts Group

Other Files

.pdf Portable document format (Adobe)
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.ps PostScript

See Also
Client, Helper Application, Internet, World Wide Web Browser

Fill, Spreadsheet
Most spreadsheets  let you paste  the same data or formula into a group of
adjacent cells  quickly, by filling. As an example, imagine an expense report
with individual expenses entered in rows  1-10, and different categories for
them in columns  A-F. We put a formula in A11 that adds up the expenses in
that category. To total the other categories, we’d select  a horizontal line of
cells starting with A11 and extending through F11 and choose the Fill Right
command, usually -R. If we wanted to paste the same material into a
vertical range of cells, we’d select an area with the desired information in
the top cell and choose Fill Down, usually -D.

Microsoft Excel  lets you fill by selecting a cell and dragging its boundary to
cover the cells to be filled. It also can guess how you’d like a series of cells to
be filled: for example, if you select a cell with “January” and extend its
boundary, its neighbors will become “February”, “March”, and so on.

See Also
Absolute/Relative Addressing; What-If Calculations
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Filmstrip
A file format for editing multiframe movies, filmstrip is supported by Adobe
Premiere , Photoshop , and After Effects . QuickTime  movies are
exported from Adobe Premiere (choose Export from the File menu) in the
filmstrip format. The file can then be opened within Photoshop and edited.
The file appears in Photoshop as a single document containing each image of
the video in sequence. The file can be painted and edited just like any other
graphics file. This makes it possible to add special effects, draw over video, or
add Photoshop effects to QuickTime movie files. The Filmstrip file can then be
imported back into Premiere and turned back into a QuickTime movie.

While filmstrip files make it possible to add short special effects or manually
fix drop-outs , they are not the best way to create lengthy rotoscoping
effects. Because the file is uncompressed, it quickly becomes large when
exporting long movie segments. You will need a lot of RAM to edit even short
segments. Consider using a program like Strata MediaPaint  if you want to
paint on long segments of video.

Final Draft
Final Draft is a word processor  for screenwriters from MacToolkit.

Screenwriters who want to sell their scripts in Hollywood find that there are
so many formatting rules and standards for margins and styles that they can
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easily get confused. When this happens, the script will usually be tossed
aside. Final Draft, from MacToolkit, solves this problem by keeping track of
formatting rules, leaving the writer free to be creative.

Final Draft has style sets that can be entered with just one or two keys on the
keyboard, so that a writer can go from perfectly set action lines to character
names to dialogue instantly. The style sets can also be user defined for your
own standards, or can switch back and forth between film and TV formats
easily.

Final Draft also has a built in spell checker and a thesaurus for breaking
writer’s block. It is fully integrated with drag-and-drop  editing, and can
import and export text to and from any other word processor.

The built-in character list saves time by having Final Draft enter characters
names from a user-defined list as soon as the first letters of the name are
typed. ScriptNotes also save time by letting users take notes as they write in
separate windows that are attached to sections of text. Final Draft then
enables you to jump to each ScriptNote and shows the corresponding text,
letting the user review comments quickly and easily.

For use by rich producers and starving writers, Final Draft will run on
everything from a Macintosh Plus to a Power Mac, and on system 6.0.7 or
higher. Final Draft is published by MacToolkit:

See Also
Drag-and-Drop; Word Processor
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Finance Programs
If you asked a hundred people what chore they were happiest to have the
computer do for them, chances are that at least half would answer
“balancing the checkbook.” Financial programs run the gamut from fairly
simple check writing and checkbook reconciliation programs all the way to
full-fledged accounting programs worthy of a CPA

Personal accounting programs are designed to help individuals and families
manage their budgets and daily expenses. These programs are designed with
a very simple check register-like interface. When you write a check, you
enter the amount, the date, and the payee, and you assign it to a category. It
might be food, or rent, or utilities, or medical expense, or entertainment. Set
up as many categories as you want. The accounting program keeps track of
the money you spend in each category, and can easily show you where your
paycheck is going. You can print out reports and graphs to show how you’re
doing this year as compared to last year, or how well you’re staying within
your budget. Some programs, such as Intuit’s Quicken , will let you tie into
electronic banking facilities, too.

Small business programs are almost as simple to use. These are usually based
on a double-entry system of debits and credits. Unlike the traditional
bookkeeping systems with journals and ledgers and many items to keep track
of, the software makes it easy to record payables and receivables as the bills
come in and go out. You can use the same programs to track inventory and to
keep the business checkbook up to date. These programs will also print
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invoices, purchase orders, and checks. Some programs will figure payroll
deductions and taxes, too. Others will work with a payroll program or tax
program, supplying the necessary input, but letting the other software do
the specialized calculations. The most popular program at this level is MYOB
Accounting . The initials stand for Mind Your Own Business, and imply,
quite correctly, that you don’t need to hire an accountant to mind your
business for you. With a program this intuitive, you can do it yourself.
Peachtree Accounting  is another modestly-priced and extremely popular
package for small business use. In addition to the basic books, it can do Job
Costing, Inventory, and Payroll. It also features a Custom Forms design
module that will let you produce any kind of paper work your business needs.
You can set up whatever kind of system you require to track the paper work,
too.

Accounting software for larger businesses can get expensive and complex.
The best known high-end accounting package is Great Plains Accounting
from Great Plains Software. It uses a set of modules that work together (but
can be purchased separately) to handle all kinds of transactions and produce
all kinds of reports and ledger pages. By the time you’ve put together a
functional accounting and bookkeeping system with Great Plains software,
you’ve spent several thousand dollars and many hours. The Macintosh
software is based on the PC version and has an extremely non-Mac-like
interface. It’s not a good choice for the beginner or for a small business, but
given the cost, it’s an unlikely choice, too. Big Business,  from Automatic
Software, is a better choice for a young, growing company. It combines sales,
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inventory, marketing and finance into one interactive package.

In addition to financial programs, there are some specialized programs to
figure your taxes. Intuit’s MacInTax helps you fill out those 1040’s and state
forms correctly, by providing on-screen worksheets and calculating the
numbers for you. You’ll still have to fill out the forms yourself, but by
following the steps in the program, you’ll be sure they’re done correctly,
and that you haven’t overlooked helpful deductions.

See Also
Big Business; MYOB; Peachtree Accounting; Quicken

Financial Planning Software
The hardest part of making money in the stock market isn’t guessing which
stocks to buy. It’s keeping track of the ones you’ve bought and sold, and the
purchase price, gain or loss, income—all those details that suddenly become
relevant at tax time. You can use financial planning programs such as
Quicken  or Managing Your Money to maintain investment accounts
(portfolio accounts and mutual fund accounts). They’ll help you track of
what you own in stocks, bonds, mutual funds, and other types of investments
that fluctuate in price. Investment accounts are for investors who want to
track investment transactions, see the performance of their investments,
update current market values, and create tax reports. When you use
investment accounts, you can see immediately whether you are making or
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losing money on each investment, compare the performance of your
investments, and report on investment income and capital gains when you
need that information to prepare your income taxes.

Investments can be entered in either an asset account or a portfolio account.
To track an investment in a portfolio account, you must know the share price
and dollar amount for each purchase or sale transaction. If you don’t have
this information, use an asset account instead. Portfolio accounts can track
multiple securities. Mutual Fund accounts track just one mutual fund. If you
have investments in several different mutual funds, you’ll need to open
separate accounts for them.

Although financial planning programs can handle most common investment
needs, their investment tracking does have limitations. While programs such
as Quicken can provide basic tax reports, they don’t keep track of changes in
tax laws. Use them to supply the numbers your accountant needs for your tax
returns, but don’t rely on them to tell you how much you owe.

Find Dialog Box

The Find File dialog box offers you options for files. When the Find File
command finds files that match your search criteria, a separate window
opens called Items Found. It lists all the items it encountered, as shown in the
figure. It shows the file name , size , kind , and modification date  of the
files to help you see if it is the file you're looking for. If you click a file, the
path to reach that file is displayed in the lower half of the Items Found
window. It may show, for example, that the file you selected is in a folder
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called “utilities” inside your applications folder on your hard drive . You
can then close  the dialog box and follow that path to the file in question.

You can also double click the item in the Find File dialog box. This launches
the program that created the file and opens the file. It’s also handy to double-
click the folder that contains the file you searched for to see what else is in
that folder.

You can search by:

• Name

• Size

• Kind

• Label

• Date created

• Date modified

• Version

• Comments

• Lock attribute

• Folder attribute

• File type
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• Creator

See Also
Close; Comments; Creator; Date Created; File Name; Hard Drive; Kind; Launch;
Modification Date; Size; Version

Find File
To find any file on your hard drive or on a selected disk, choose Find File
from the Apple menu.  The Find File dialog box  offers you a wide range of
options for searching for your selected files. When the Find File command
finds files that match your search criteria, a separate window opens called
"Items Found" and it lists all the items it encountered. It shows the filename,
size, kind, and modification date  to help you see whether the file is in
fact the one you're looking for. If you click a file, you'll see the path to that
file is displayed in the lower window of the "Items Found" window. It may
show, for example, that the file you selected is in your hard drive, inside your
applications folder, and is inside a folder called Utilities. You can then close
the dialog box and follow that path to the file in question.

You can also double-click the item in the Find File dialog and if that
document can be opened, it will launch the program that created it and open
the file.

You can search by: name, size, kind, label, date created, date modified,
version, comments, lock attribute, folder attribute, file type, and creator.
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If you know the name of the document, a name search might bring you the
fastest results. But the other search criteria are helpful as well. If you don't
know the name of the file, but remember that it's over 4MB, you can search
for all files greater than 4MB. Or you might not remember the name of your
file, but if you knew you created it last Thursday, you can use the date created
search to list all the files created on a particular date. The date modified is
excellent if you need to see which files need to be backed-up.  There's a lot
of flexibility to help you find misplaced files.

When you select a search criteria, such as name or size, the Find File dialog
gives you a pull-down menu with options to help you narrow your search.
For example: If you know the name of the file you're looking for contained
the word Red, but you didn't remember the full filename, you can search for
files that contain the word Red. But if you knew for certain that the file
started with the word Red, you can search for files that start with the word
Red. You'll see the button "More Choices" in the Find File dialog. This enables
you to set more specific details for your search and is helpful in narrowing
your search. Each time you click the More Choices button, another layer of
choices pops up (until you reach ten lines of criteria for your search). This
way, rather than finding every file on your hard disk that starts with the
word Red, if you know some details about the missing file, you can narrow
your search to the most likely file. If, for example, you knew the file size was
small, and you knew you created it on Feb. 11th, and you knew it was a font;
you could set a search up that would find only the file's that are: less than
50K (you insert the size), that were created on Feb. 11th, and that are fonts.
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After you've decided which search criteria you're going to use to get the
fastest, most effective search, you need to decide where you want to search.
The Find File dialog enables you to search a particular disk, all disks, or even
over a network to a server.

To find a file, follow these steps:

1. On the File menu, choose Find ( -F).

2. When the Find File dialog box appears, enter the search criteria
(name, size, and so on) for the file you're looking for, and indicate
where you want the Find File command to look for your files.

3. Click Find to begin your search.

4. If the Find comes up with any files that match your criteria, it will list
those files in a new window entitled "Files Found" displaying the
filename, size, modification date, and so on.

5. To see the path of an individual file, just click the filename and the
lower portion of the Files Found window will display the path to the
file you've selected. You can also double-click to launch the file (it's a
launchable document).

 See Also
Apple Menu; Back Up; Dialog Box; Find File Search Options; Kind; Modification
Date; Server; Size
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Find File Search Options
The Find File DA  has keyboard shortcuts  that enable you to increase or
decrease the number of search options displayed in the Find File window.
Press Command-M to see more options and Command-R to see fewer.

See Also
Find File DA; Keyboard Shortcuts

Find File Tricks
In Apple's Find File DA, there is a series of find attributes hidden beneath the
surface. When you open the Find File dialog box, the first field contains a
pop-up menu that lets you search by Name, Size, Kind, Label, Date Created,
Date Modified, Version, Comments, Lock Attribute, Folder Attribute, File Type,
and Creator. But if you hold the Option key before select this field, you find
four more attributes have been added to the list: Contents, Name/Icon Lock,
Custom Icon, and Visibility.

Probably the most important search criteria added by holding the Option key
is the Contents search, which searches your hard disk for items that contain
the key word you're searching for as a text item. If, for example, you were
writing about Spain but didn't use the name Spain in the title of the
document, by using a Contents search, you can search for documents that
contain the word Spain.
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Searching by Custom Icon brings you a list of files that have had their
original icon replaced by a custom icon. This can help you narrow the scope
of your search if you know that you either did or did not replace the original
application’s or document’s icon with a custom icon.

The Visibility attribute lets you search for invisible items and is especially
helpful for finding invisible files that some applications put in your System
Folder  when you install the program from an installer.

In System 7.5 , you can drag a file into the third search field (right above
the Find button), and the attributes of that file are entered into the find
fields. If, for example, you choose a find attribute from the pop-up menu,
such as Size, the file's size is already inserted. If you choose Kind, that file's
kind appears in the Kind field. This is helpful when searching for a similar
file based on that type and/or creator information.

When you do a search with the Find feature, the window that appears with
the listing of files that match your search criteria has many of the same
features as the Finder. The files in this window can be double-clicked and
launched, just as in the Finder . You can also click an item on the list and use
the Get Info  command (Command-I) to see the file's information. To print an
item, you can press Command-P, and to open an item you can press Command-
O.

Although the Find File function is greatly enhanced in System 7.5 and
higher, you can still access the System 7  Find File function (which many
users are still very fond of) by pressing Command-Shift-F. This will bring up

F



the old Find File dialog box introduced in System 7.

See Also
Find File; Finder; Get Info; System 7; System 7.5; System Folder

Find Command
To find any file on your hard drive or on a selected disk, choose Find from the
File menu  at the Desktop ( -F). This brings up the Find File dialog box.

The Find File dialog box offers you a wide range of options for searching for
selected files. When the Find File command finds files that match your search
criteria, a separate window opens called "Items Found,” which lists all the
items it encountered.

This window shows the filename , size , kind , and modification date  to
help you decide if it’s the file you're looking for. If you click a file in the
window, the path to reach that file is displayed in the lower window of the
"Items Found" window. It may show, for example, that the file you selected is
in your hard drive , inside your applications folder, and is inside a folder
called “Utilities.” You can then close  the dialog box and follow that path to
the file in question.

You can also double-click the item in the Find File dialog, and if that
document can be open, te program that created it is launched  and the file is
opened. You can search by: name, size, kind, label, date created , date
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modified, version , comments , lock attribute, folder attribute, file type,
creator.

If you know the name of the document, a name search might bring you the
fastest results. But the other search criteria are helpful as well. If you don't
know the name of the file, but remember that it's over 4MB, you can use the
Find File command to list all files greater than 4MB. Or you might not
remember the name of your file, but if you know you created it last Thursday,
you can use the date created search to list all the files created on a particular
date. The date modified is excellent if you need to see which files need to be
backed-up.  There's a lot of flexibility to help you find misplaced files.

When you select a search criteria, such as name or size, the Find File dialog
gives you a pull-down menu with options to help you narrow your search. If,
for example, you know the name of the file you're looking for contained the
word Red, but you don’t remember the full filename, you can search for files
that contain the word “Red." But if you knew for certain that the file started
with the word Red, you can search only for files that start with the word Red.
The More Choices button in the Find File dialog enables you to expand your
searching capabilities by giving you more choices and more criteria
selections with which to search .

After you've decided which search criteria you're going to use to get the
fastest, most effective search, you need to decide where you want to search.
The Find File dialog enables you to search a particular disk, all disks, or even
over a network  to a server.
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To find a file, follow these steps:

1. From the File menu, choose Find ( -F).

2. When the Find File dialog box appears, enter the search criteria
(name, size, and so on) for the file you're looking for, and indicate
where you want the Find File command to look for your files.

3. Click Find to begin your search.

4. If the Find comes up with any files that match your criteria, it lists
those files in a new window displaying the file's name, size,
modification date, and so on. This is the “Items Found” window.

5. To see the path of an individual file, click the filename and the lower
window displays the path to the file you've selected. You can also
double-click to launch the file.

See Also
Backing Up; Close; Creator; File Menu; Filename; Hard Drive; Launch;
Modification Date; Network; Server; Size; Version Number

Find Again Command
This command was used in the System 7 and 7.1  version of Apple's Find
function. When you choose the Find  command, the first object found in its
search appears in an open window. If the found file is not the file you were
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looking for, you can continue your search by selecting Find Again ( -G)
from the File menu at the desktop . This was designed as a time saver in case
you want to continue your search using the same word. Bringing up the Find
File dialog box every time when you are continuing the same search is time-
consuming and unnecessary.

Because of improvements to the Find File function in System 7.5 , Find Again
is used only to repeat the same entire search cycle again. Find File Again is
not as necessary as it once was because the Find File function now displays
all matches at once in the Find File window, rather than bringing you each
match one by one.

To use Find Again to continue a search, follow these steps:

1. From the File menu, choose Find Again ( -G).

2. The search for the file continues using the last word entered in the
Find File dialog box.

See Also
Desktop; File Menu; System 7; System 7.1; System 7.5

Finder Scripting Extension
This System 7.5 extension adds the capability to use AppleScript  to automate
repetitive tasks at the Finder.
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See Also
AppleScript; Finder

Finder Shortcuts
There are many keyboard shortcuts available at the Finder. A list of these
shortcuts appear in under the Help menu (The question mark icon, to the
left of the Applications menu  on the far right of the menu bar. When you
pull down the help menu at the Finder, the last item is named Finder
Shortcuts. If you select Finder Shortcuts, a dialog box  will appear with a
brief explanation of the command along with its keyboard shortcut. Many of
the commands listed in Finder Shortcuts are hidden commands, meaning they
can only be executed through the keyboard, and a menu with the command
does not appear anywhere in the Macintosh Operating System. An example
would be: Rebuild Desktop.  There is no pull-down menu for this command,
so a keyboard command is used instead, and they are listed in the Finder
Shortcuts command.

See Also
Applications Menu; Dialog Box; Help; Help Menu; Keyboard Shortcuts; Rebuild
Desktop

Finder, Speed Tips
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There are a number of preferences you can set at the Finder  that can help
to speed up your work. The first speed enhancement comes from
understanding that everything that appears on your Mac in a window takes
time to redraw on the screen, and certain items redraw faster than others.
Some of these preferences are controlled from the Views Control Panel .

In the Views Control Panel, you can select what font you want to use for
displaying filenames in the Finder. If you want to have the fastest screen
redraw, leave this font at the default choice of Geneva. If you choose a font
other than Geneva, it takes slightly longer to display. Another speed
enhancement from the View Control Panel is making sure the "Calculate
folder sizes" checkbox is not checked. When you have this feature on, the
Mac calculates the size of each folder and displays this info in list view
windows. This calculation is memory intensive and tends to slow things down.
For folders with a large number of items in it, such as your fonts folder, you
have to wait for the calculation to take place, and it can slow redraw down
considerably. By unchecking this, the folder still appears in all list views,
but the size of the folder is not calculated. Note: If you ever need to know the
size of a folder, you can always select the folder and choose Get Info
(Command-I).

Another way to speed up performance is caused by the fact that color objects
take longer to redraw than black and white objects. If you switch your
monitor setting to black and white in the Monitors Control Panel , for
example, you feel an instant jump in speed because the screen redraws more
quickly if it doesn't have to use color.

F



See Also
Finder; Monitors Control Panel; Views Control Panel

Finding Files on the Internet
See
Archie

Finding Out A Device's SCSI ID Number
If you have an external hard disk or any other peripheral connected to your
Mac through a SCSI port, you can find the SCSI ID number without looking on
the hardware itself. You do this by selecting the device and choosing Get Info
(Command-I) from the File menu. In the Get Info window, beside the heading
"Where:" you'll see the name of the disk, which software was used to format
the disk, followed by the SCSI ID number.

See Also
Get Info; Hard Disk; SCSI

FinePrint
See
Printers, PostScript Lasers
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Finger
An Internet protocol used to provide information about host computers; also,
the name of a scriptable application by Peter Lewis that is used to look up
individuals or other information on the Internet .

Finger gains access to a host  computer via port number  79 using the
Finger protocol. What finger finds depends on the information stored in a
Plan file set up by the server administrator. Some servers let you see the
names of users who have connected to their site, and the times they
connected. Others provide a variety of personal information about the
administrator.

Finger is scriptable with AppleScript, and the following figure shows the
results of an AppleScript that activated Finger automatically and connected
to a remote Web server  to reveal who has visited it recently.

See Also
Host; Internet; Port Number; World Wide Web, Searching

FireWire
See
Ports, Future Trends, 1394 FireWire
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First Person Perspective Shooters
The first Doom-like game, Wolfenstein 3-D showed up for the Mac in 1994.
Even though it took two years to move from the PC to the Mac, it was clear
that id software was onto something and Mac gaming would never be the
same again. The Doom phenomena consists mainly of this: a guy running
through corridors, shooting everything in his path. If the game is network
compatible, then you can play with a friend and shoot him too. First Person
Perspective Shooters  (Shooters ) are logical extensions of standard
"shoot to kill" theme, but tend to incorporate a bit more of a plot. In
Wolfenstein 3D you are a soldier fighting the Nazis, while in LucasArts’ Dark
Forces, you seek and destroy the Empire’s newest bad guy, the Dark Trooper.
Especially when primed for the Power Mac , Shooters are a joyride of sight
and sound with lots of repetitious button punching and rapid-fire. The Power
Mac’s faster processing and advanced video puts you in the middle of the
action. However, many of the games are violent and tend to stir up a bit of
controversy.

Regardless of its “gore quotient”, Doom II,  distributed by GT Interactive, sold
millions of copies on both the PC and the Mac. Shooters incorporate a first
person perspective that makes you feel like you are actually tramping
through corridors or through the underbrush. Instead of looking at a
character that you guide across the screen, your line of vision is what it
would be like to really be there. Some titles accomplish this better than
others with great graphics and sound, but all tend to have the same elements
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including a menu bar along the bottom of the screen that lets you know how
injured you are and what guns you’ve got.

Shooters that model themselves after arcade video games like Mad Dog
McCree, where you shoot video images of actors on a large screen with a toy
gun usually tend to fall flat on smaller platforms. Neither Mad Dog, Blood
Bath or the disastrous Crime Patrol, all distributed by American Laser Games,
have been able to match the sales success of the Doom phenomena. Id
Software is the leader in making these titles with Wolfenstein 3D, Doom II
and Ultimate Doom to their credit, as well as the new Hexen: Beyond
Heretic. Other First-Person Perspective Shooters worth checking out
include Sensory Overload, Marathon, and Marathon II from Bungie Software
and the LucasArts Star Wars game Dark Forces. Even a level of the LucasArts
game Rebel Assault II  incorporates the first person perspective.

See Also
Descent; Doom II; Hexen: Beyond Heretic; Marathon; Violence in Games

First Things First
Visionary Software’s Organizer/Personal Information Manager isn’t the
easiest one to use, but it’s extremely powerful and optimized for the Power
Mac . It combines a calendar—daily, weekly, monthly, or yearly—with a very
good outliner, and a floating clock/calendar page that also can be anchored
to the menu bar. First Things First can be networked and shared by co-
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workers, but you can determine whether they can change calendar items or
just look at them and be reminded of group meetings and tasks you’ve
delegated.

Use the outliner first to develop your goals and plans. Use the outline’s
hierarchy to decide what’s most important, then add the sub-set of things to
do to reach the goal. When you’re ready to set a time to accomplish specific
tasks, drag them to the calendar. Set dates and times for meetings,
appointments, and reminders. FTF’s calendar can do as much as any other
calendar can to keep you on a schedule. It reminds you of appointments with
a burst of music, unless you tell it to use one of your other system sounds. You
also can use voice annotations on your calendar if you have a microphone.

The First Things First toolbar toggles back and forth between the outline and
calendar views and gives you quick access to the linking and sharing
features. It can print your calendar in any of the standard formats, including
FiloFax, Day-Timer, Day Runner, and Franklin Planner, as well as on standard
sheets of paper. It prints your outlines in any format you want, with or
without hidden items, or only text you’ve selected.

First Things First is available as a demo program from online services  and
bulletin boards. The demo can be upgraded to a full working version by
calling the publisher, Visionary Software, with your credit card in hand and
buying a registration number. It’s an ecologically sane way to distribute
software. There’s no wasted packaging. The program includes excellent help
files, so you have no real need for a printed manual. Best of all, you can try
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out the software for as much as a month before you buy it—an excellent
policy.

See Also
Personal Information Manager

FirstClass
BBS (Bulletin Board System ) software by SoftArc. With FirstClass and a
special add-on gateway to the Internet , a Macintosh BBS can include a clean
graphical interface and an email  and Usenet  news connection.

Most of these sorts of Internet connections are handled through UUCP
gateways, which means the FirstClass BBS calls an Internet host  every few
hours to transfer email and news.

It’s also possible for a FirstClass BBS to be accessible over the Internet. You
can come in by way of a standard Telnet  session or via the graphical
FirstClass software, configured to use a Telnet tool, if you have a MacTCP -
based connection to the Internet. To find a Telnet tool you might use a
telecommunications package such as MicroPhone, by Software Ventures
Corp.

To configure the FirstClass client software to use Telnet:

1. Click the “Setup” button in the main screen and the “Change” button
in the “Connect Via” part of the “Connection Settings” dialog.
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2. In the “Communications Setup” dialog, choose “CommToolbox” from
the “Connect Via” pop-up menu.

3. Click the “Configure Tool” button to choose your Telnet tool, and
configure it with the Internet address of the host BBS. After you
connect to a FirstClass BBS over the Internet, it looks just like any
other FirstClass BBS that you’d call via modem.

FirstClass can receive Usenet  newsgroups via the Internet gateway, which
is an excellent way to bring more information into a fairly small BBS.

To send email on a FirstClass system, go to the “Message” menu and choose
“New.” FirstClass presents you with a message window. To send a message to
the Internet, type the Internet address and append ,Internet  to it.

You can get more information about the FirstClass software from SoftArc by
sending email to sales@softarc.com. You can download the free FirstClass
client software from any FirstClass BBS, or on the Internet at:
ftp://ftp.tidbits.com/pub/tidbits/tisk/bbs/first-class-client-209.hqx.

See Also
Bulletin Board System; Email; Internet; Telnet; Usenet

Fixed Storage Capabilities
See
Disks and Drives
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Flagging
A way of finding a message more easily the next time a user is searching
through a Usenet  newsgroup without actually saving the message to
disk.The “Flag Messages/Unflag” command on the “Message” menu in
Netscape Navigator  either adds or removes the Flag icon under the
“Mark” column.

See Also
Lurking, Netscape Navigator, Subscribing, Thread, Usenet

Flaming
Sending a “heated” message to a fellow electronic mail correspondent,
mailing list member, or newsgroup  user in regards to a breach of
“netiquette ” on their part. Any thought, opinion, or feeling expressed is
subject to a response calling into question your intelligence, common sense,
and parentage. People often flame companies or large organizations,
particularly the government. This often starts a “flame war” if other people
don’t share your opinions on a major topic. Avoid flaming other people as
good netiquette .

See Also
Mailing List, Netiquette, Newsgroups, Spam, Usenet, World Wide Web
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Flash It
Flash it is a third-party shareware  program for System 6.0.3 or higher, that
enables you to take screen captures , but adds features and functionality
that Apple's Shift- -3 screen-capture command doesn't offer. For example,
when you activate Flash It, your cursor turns into a cross hair cursor, and
enables you to drag a selection around any item and save just that selected
area as your screen capture, rather than saving the entire screen. This
makes for smaller-sized captures, and requires less editing or cropping of
your screen capture if all you want is a portion of the screen.

Flash It is a Control Panel,  and its preferences are set within the control
panel, as shown in the following figure. In the control panel you can select a
hot key that will activate Flash It, you can select which type of file format
to save the capture in, and you can set where on your hard disk  you want
the screen captures saved. Flash It can be found in the Macintosh Utilities
Forum on America Online and a variety of Mac FTP sites on the Internet.

See Also
Control Panel; File Format; Hard Disk; Screen Capture

Flat Shading
See
Rendering
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Flat-File Database
A flat-file database is one that contains only one file of data. There may be
many individual records in the file and many fields in the record, but
they’re accessible only from the file, and aren’t shared with any others.

A cookbook is an example of a flat-file database. Each recipe is a record, and
the ingredients and instructions are fields. A HyperCard address stack like
the one in this example is a flat-file database. In order to transfer the name
and address to a letter, you’d have to copy it.

See Also
Database; HyperCard

Flatbed Scanners
Flatbed scanners are the most commonly-used kind of scanner in desktop
publishing. In the mid-90’s, high-end flatbed scanners can produce scans
that are nearly as good as drum scans, and fairly inexpensive flatbed
scanners are perfectly adequate for comps, artwork for Web pages, and many
printing projects.

Flatbed scanners are also useful for optical character recognition (OCR)
tasks. Using OCR, you can quickly enter printed documents into word-
processing documents, rather than retyping the text of the documents.
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Flatbed scanners can handle a wide range of materials: photographic prints,
pages from books or magazines—you can even scan flat objects, like coins,
directly. Many flatbed scanner handle large-format transparencies, or can
be equipped with adapters to handle transparencies and even slides. Some
desktop scanners also support sheet-feeder attachments for multi-page OCR
jobs.

Flatbed scanners look like a small, personal copier. Artwork is placed face-
down on the scanner’s glass plate and the scanner moves a light bulb and
sensor beneath the art. Some scanners pass a bulb over large-format
transparencies, shining the light through the art and into the sensor.

Advantages  Flatbed scanners range widely in price and quality, but good
scanners are fairly inexpensive. A flatbed scanner adequate for comps, Web
pages and OCR can be purchased for a few hundred dollars. In 1996, a high-
quality flatbed scanner that can be used to produce scans for print can be
purchased for as little as $2000.

Flatbed scanners are fairly easy to operate. It takes some practice to get
consistently good scans from any scanner, but flatbeds are substantially
easier to use, and faster, than drum scanners.

Drawbacks  Flatbed scanners use CCD’s to record artwork’s light and dark
values. (See the discussion of drum scanners.) Often, this can result in loss of
detail in highlight and shadow areas of the scan.

Scans from flatbed scanners are very rarely in as sharp focus as drum scans.
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It’s possible to compensate for this with software (such as Photoshop’s
“Unsharp Mask” filter), but such corrections may cause unwanted side-
effects in the scan.

See Also
Drum Scanners; Handheld Scanners; Office Scanners; Slide Scanners

Flattened Movies
Macintosh files contain two parts or forks : a data fork and a resource fork.
The resource fork stores icons, palettes, and so on, while the data fork usually
contains the major portion of data, such as the text in a word processing
document. The PC operating system does not support this structure, so it is
necessary to create a flattened QuickTime  movie for distribution to PCs. A
flattened file contains only a data fork. Utilities such as Who's MovieShop
and Who's MovieCleaner  provide this option, as well as Adobe Premiere .

Flight Simulators
See
Sim Games

FlipBook
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S. H. Pierce and Company’s FlipBook is dedicated printer software that allows
you to create traditional paper flip books from your digital animation files. A
QuickTime or PIC movie is loaded onto the screen, along with a playback
controller that shows each frame in the sequence (not in frames per second
rate).

Your printers specs are indicated, and you are allowed to format the flip card
printout in the Flip Setup dialog. From there, you print out the frames of the
loaded movie file to the flip cards loaded in the printer. FlipBook comes with a
small stack of flip cards and an order form for more.

Floating Point Coprocessors
See
Coprocessors, Types of, Software FPU

Floppy Disks and Disk Drives
All Macintosh storage media is composed of an iron-oxide (rust) coating on
some type of substrate. Floppy disks consist of iron-oxide coated plastic (like
that in a cassette tape) platter with a hole in the middle, that is surrounded by
a protecting case of hard plastic.

Floppy disks simply hold information. They need a mechanism to use this
information. That machine is called a disk drive. Disk drives read or write
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data from a floppy disk in a several step sequence. The disk first spins to
where the data is located. Then the read-write arm moves out or in to that
spot and touches the disk to change the magnetic coating. The floppy disk
drive motor must spin the disk and move the arm each time a read or write is
requested by the Macintosh, making data access times slower than that of the
hard disk drive. When floppy drives are being written to or read from they
spin at a rate of approximately 390 to 600 revolutions per minute.

There are three types of disk drives: single-sided disk drives that are capable
of reading only one side of the older, single-sided 400K floppy disks; double-
sided disks drives that are capable of reading both sides of an 800K floppy
disk; and the Super Drives, which are capable of reading two sides of a high-
density 1.4MB disk.

The older 400 and 800K disks have a variable rotation speed, this is because
the outer tracks are longer than the inner tracks. Using a different speed to
turn the disk to information stored on the outer tracks than that used to
access data on the inner tracks enables the disks to hold more information.
Out of a total of 80 tracks, the outer 16 tracks have 12 sectors each; the next 16
tracks contain 11 sectors each, descending in sector quantities to the inner
16 tracks that have 8 sectors each. Each sector holds 512 bytes of data. High
density disks use a fixed rotation speed to enable them to be interchangeable
with MS-DOS-based computers.

See Also
Disks and Drives; Formatting; Hard Disks; Initialization
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Flow Control
When an RS-232  connection is made between your Macintosh and a modem,
both devices need to be ready to send and receive information
simultaneously. However, in real-world situations the Mac occasionally has
data ready to send faster than the modem is able to accept. And along the
same lines, there are times that Mac is temporarily unable to receive data
from the modem, possibly because it is busy performing another task, such as
printing. Obviously if either side simply “loses” the information being
transmitted, the communication as a whole could fail, leading to
unpredictable results. To prevent data loss, the modem and the computer
make use of Flow Control to keep both sides informed of each other’s
readiness.

Older, slower modems were able to handle flow control through software, in a
process known as XOn/Xoff . This “Software Flow Control” functioned by
inserting characters into the stream of data being transmitted to indicate
when to pause and resume. When the modem wanted the computer to stop
transmitting (pause), it would send ASCII code 19 ( Control-S, XOFF) When the
modem was ready to resume transmission, it would transmit the XON
character (ASCII 17, Control-Q) to inform the computer that it was ready to
resume transmission.

As modems speeds grew and modem users began transmitting binary files
that actually contained the XON and XOFF characters as a part of the files, this
type of flow control became less practical.
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Today's high speed modems perform the function of flow control by using
the RTS  and CTS pins in the modem cable, through a process known as
Hardware Handshaking . These modems require a particular type of cable,
which supports hardware handshaking. When the computer needs the
modem to slow down, it drops the power on the RTS pin, signaling the modem
to pause. In the opposite scenario, when the modem has fallen behind the
computer, perhaps because of a temporary influx of line noise, the modem
drops the CTS line to ask the computer to slow down and stop transmitting
data.

One additional pin of interest for handshaking in a RS-232 serial cable is the
DTR pin. This pin is used by the computer to signal the computer’s overall
readiness to the modem. Modems are generally configured to hang up when
the computer drops the DTR pin, thus assuring the computer that a telephone
line doesn’t stay connected for an unexpectedly long period of time, and
quickly preparing the modem for another call (after DTR is raised again).

In most computers the story stops here: the modem simply watches for the
DTR and RTS pins to keep an eye on the computer, and the computer watches
the CTS pin to keep an eye on the modem. A drop in RTS signals the modem to
slow down, a drop in DTR signals the modem to hang up, and a drop in CTS
signals the computer to slow down.

Unfortunately, the Macintosh makes use of these pins in a somewhat
different way than in other systems. The DIN-8  RS-232 connector used in the
Mac’s serial ports has only one signal control pin, allowing it to provide the
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modem with either a DTR or  a RTS signal — but not both. To accommodate this,
Macintosh hardware handshaking cables tie together the DTR and the RTS
lines coming from the Mac, meaning that DTR and RTS lines will always be
the same from the perspective of the modem. Therefore, when connecting a
Mac to an RS-232 modem, you need to configure the modem to monitor either
the RTS pin (to provide full hardware handshaking) or to monitor the DTR
pin (to watch for the computer’s desire to hang-up the modem).

Because both DTR and RTS will always be the same from the modem’s
perspective, it is very important to configure the modem to ignore one or the
other. Generally, terminal software used to connecting to on-line services
will make use of the Hardware Handshaking feature (RTS), and therefore
your modem should be configured to ignore DTR (usually done via the AT
&D0 command). In this case, if you do not configure the modem to ignore
DTR, when the computer needs the modem to slow down, it will drop its signal
control pin, resulting in the modem seeing a drop RTS and  DTR. The drop in
the RTS pin will tell the modem to slow down as expected, but because DTR is
also dropping, the modem will drop the line instantly!

Nearly all modem software today is configured to make use the RTS pin of the
modem cable. However, in some cases, software is specifically designed to
make use of the DTR line instead of the RTS line. Most notably, Apple
Remote Access 2.0 (ARA)  specifically configures the Mac not to provide
RTS signals, and leaves the modem set to hang-up on drop of DTR. Since ARA
provides its own compression and correction, Apple’s engineers feel that the
computer would rarely, if ever, need the modem to slow down, and thus the
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ability to quickly hang up and reset the modem is more valuable. Fortunately,
your ARA CCL string will take care these settings for right for Apple
Remote Access, so beyond technical curiosity, you needn’t be excessively
concerned about what ARA is doing with DTR.

If you are installing a new high-speed modem, be sure that you use a
hardware handshaking cable. Otherwise, it won’t work properly and you can
spend days trying to figure out what’s wrong.

See Also
Networking

Flush Left
See
Printing Terms

Flush Right
See
Printing Terms

Flying Games
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See
A-10 Attack!, Sim Games

Flying Nightmares
See
Sim Games

FM Screening
See
Stochastic Screens

Focal Length
This measurement indicates how much of a scene the lens captures.
Expressed in millimeters (mm), it is the distance from the optical center of
the lens to the film plane when the focus of the lens is set to infinity. The
smaller the number, the wider the field of view of the lens. The wider an area
is visible, the smaller objects will appear in the picture.

For a 35mm camera, a 50mm lens is considered a standard or normal lens,
while a 28mm is a wide angle and a 150mm is a telephoto. However, this
changes depending upon the size of the film (or CCD in the case of digital
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cameras) being used. For example, medium format (2 1/2") cameras use 80mm
as the equivalent standard lens, while a CCD camera with a detector less than
an inch in size may have a standard lens of less than 40mm.

See Also
Digital Still Cameras; Range Finder; SLR

FocolTone
Providing designers 763 ink spot colors, the FocolTone spot color system also
allows all its colors to be converted to CMYK with reasonably accurate results
(unlike the more popular Pantone color system).

See Also
CMYK; Pantone; Spot Color; Toyo; TruMatch

FotoTune
Agfa, a maker of high-resolution imagesetters and scanners, has its own
solution to color management , called FotoTune. This package can produce
device profiles  for monitors and RGB scanners; it supports the use of the
Colortron II spectrophotometer (a color measuring  device) to create
monitor profiles. A large selection of printer profiles is provided for desktop
printers, printing presses, and film recorders.
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See Also
Color Management; Device Profiles; Measuring Color

Folder
See
New Folder Command

Folder Icon
The Folder icon, which by default looks like a file folder, is used to let you
know that files and other folders can be placed within this folder, as shown
in the following figure. Folders  are used as an organizational tool for
keeping files in the computer separate from each other, much the same way
real file folders keep files separate in a traditional file cabinet.

The System Folder has a number of folders with special icons on them to help
you distinguish these folders from other folders. The Apple Menu Items
folder, for example, has a small Apple logo to help you distinguish it from the
dozens of other folders in your System Folder. The fonts folder has a capital
"A" on the folder to alert you, and the Control Panels folder has an icon of a
slider and some buttons to help you visually locate it as well. The Extensions
folder, Startup Items folder, Launcher Item folder, Preferences folder, and
Print Monitor Documents folder all have this added visual cue to help you
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locate them in the System Folder.

See Also
New Folder Command

Fondler
See
Font Utilities

Fonts
More than any other type of software, fonts offer users an incredible variety
and quantity to choose from. The Precision Type Font Reference Guide, an
extraordinarily complete type specimen book, lists more than 13,000 digital
typefaces, and that’s not complete by any means all. For one thing,
shareware  fonts aren’t included in the guide.

Mac users will find there’s a font for their every mood, and they’re as easy to
use as choosing a name from a menu. There are some format, compatibility,
and management issues to consider, but for the most part using fonts is
strictly fun.

Type has come a long way since Gutenberg. Originally, printers cut their
own type from metal, and in the 16th century type designers, such as Claude
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Garamond, began to manufacture and sell their typefaces all across Europe.
Over the next few centuries, type foundries formed an industry all to
themselves. The word “font” (or “fount”) is derived from the word
“foundry,” where, originally, type was cast. Today companies that create
fonts are still called foundries, but those fonts are more likely to be digital
than metal.

Type foundries  range from huge companies like Adobe—which along with
selling thousands of fonts is also the creator of the PostScript  page
description language that’s the basis of desktop publishing—to tiny one-
person shops that distribute their fonts as shareware .

Over the centuries, type has mutated into many categories: oldstyle,
transitional, modern, slab serif, sans serif, script, cursive, brush, graphic,
display, decorative, blackletter, uncial, pi, symbol, logo, ornament—there are
more, but these cover most typefaces available today. Some of these names
come from the history of type (oldstyle, for example), while others describe
the design of typefaces (brush) or their use (symbol). For most users, though,
the categories to be concerned with are serif (like Times), sans serif (like
Helvetica), and ornament fonts (like Zapf Dingbats).

The Mac’s system software comes with certain fonts. Some vary from version
to version (System 7.5 comes with some GX fonts  that other systems don’t
have, for example). But every Mac comes with the following:

• Geneva—This is used primarily for display of file names and
information within windows in the Finder. It was originally based on
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Helvetica (the name Helvetica comes from the Swiss name for their
country, of which Geneva is the capital).

• Chicago—This is used for menu and window titles.

• Monaco—This is a sans serif font that’s monospaced —each character
takes up the same width as every other, like typewriter letters. It’s also
used by the Mac system software.

• Times—Originally created for the London Times newspaper in the
1930s, Times is widely used in all sorts of publications. It’s the closest
thing to a generic serif font that there is; it falls into the transitional
category of typefaces, because it’s similar to the transitional typefaces
of the 17th century.

• Helvetica—The closest thing to a generic sans serif typeface, Helvetica
is probably even more widely used than Times.

• Courier—This is a monospaced font designed to look like typewriter
letters.

• Symbol—This font contains symbols used for typesetting mathematical
equations, including mathematical operators and most of the Greek
alphabet.

• New York—Based on Times, New York is preferred by many for screen
display, because it’s larger and more open, therefore easier to read
onscreen.
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• Palatino—An elegant but much over-used font, Palatino was designed
by Herman Zapf, a famous 20th-century type designer whose name is
widely known even outside the world of typography because of the
next font in this list.

• Zapf Dingbats—These are ornamental characters useful for replacing
bullets in bulleted lists and for other decorative applications.

Mac fonts come in more than one format: PostScript , TrueType , and GX
(which can actually be PostScript or TrueType). Often, a typeface is
available in more than one format, so users can choose which best
meets their needs. Font formats are important under the following
circumstances:

• In desktop publishing, most high-resolution output devices don’t work
well with TrueType fonts, even though the output quality of TrueType
is essentially the same as that of PostScript. For this reason, most
desktop publishing is done with Type 1 PostScript fonts.

• If you have a typeface in more than one format, you should only have
one format installed at any given time. Graphics applications and
output devices can be confused when they encounter two conflicting
font formats.

• If you don’t have a PostScript printer and your files aren’t destined to
be printed on one at a service bureau, you can’t use PostScript fonts.
TrueType fonts are a good alternative in this case.
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Buying Fonts is easier today than ever. They are available at retail stores, by
mail order from Mac catalog companies, from the individual foundries
themselves, and from distribution companies like Precision Type. A welcome
innovation in the past few years is the introduction of font libraries on
compact disc, like Adobe’s Type On Call, which contain entire catalogs of
fonts from particular foundries. Users call or fax the CD’s publisher to order
fonts, and in return they receive (within a few minutes, usually) a code that
allows them to copy the fonts from the CD. Before buying, users can view
samples of all the fonts on a disc, as well as historical and design information.

Shareware fonts are an alternative to commercial fonts. Generally much less
expensive than commercial fonts, they have the potential to be of just as
high quality, and the variety available is incredible. Let the buyer beware,
though: Many shareware fonts don’t contain all the special characters,
ligatures, and kerning  pairs that can make commercial fonts worth the
money.

See Also
Buying Fonts; Font Formats; Foundries; GX Fonts; PostScript; Shareware;
TrueType; Type Foundries and Distributors; Typesetting Terms

Font Conflicts, Numbering
Each font  has a font ID number assigned to it by its developer. If you have
two fonts installed on your Macintosh that have been given the same font
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number by their developers, you have a font ID conflict. The conflict occurs
when the Macintosh doesn't know which font you want to print . If, for
example, you want to use a font called Tribeca, which has a font ID number of
9070, and you also have a font installed on your system called Fisheye, which
also has a font ID number of 9070, the Mac doesn't know which font to print.
To resolve this conflict, the Macintosh prints the first one it comes to,
regardless if it’s the font you wanted or not. If you selected Tribeca, Tribeca
is displayed on your screen, but the font FishEye prints instead, that's a font
ID conflict

Font utilities  such as Suitcase (from Symantec) and Master Juggler
(from Alsoft) warn you if you're about to open a font that has the same ID
number as a font you already have open. The new version of Suitcase
(version 3.0) automatically renumbers fonts for you when necessary, but it
only renumbers them temporarily (in RAM) and does not change the
permanent number of the font.

Both utilities offer to automatically renumber the new font for you so it has a
distinct number from any other font you have open. You can also choose to
leave the numbering as is and instead close the font with the same ID
number on your drive. If you're going to output your files at high resolution
through a service bureau or digital imaging center, it is generally
recommended that you do not renumber your fonts. That is because
renumbering only works on your machine. When you take your files to a
service bureau, your renumbered fonts won't match up with their fonts, and
you'll again have a font ID conflict. In other words, your fonts will not
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correctly match up.

See Also
Fonts; Font Utilities; Master Juggler; Printing; Suitcase

Font/DA Mover
This is an Apple utility that was necessary in System 6  for installing fonts
or desk accessories  (DAs) into your system. Back then, all fonts and DAs
came in little suitcases, and by using the Font/DA Mover (whose icon looked a
little truck) you would move these fonts and desk accessories in and out of
your system. Installed DAs appeared under what is now called the Apple
menu.

To install a font with the Font/DA Mover, you would double-click the Font
suitcase and it would launch the Font/DA Mover and open the suitcase,
revealing its contents in a window on the left side of the dialog box. You
would then select the fonts or desk accessories you want to install and click
the Copy button, and it would copy the selected items into the System.

System 7  and higher have made the Font/DA Mover obsolete, as you can now
install fonts by just dragging them into the Fonts folder (within the System
Folder) or by dragging fonts onto the System Folder icon, which places it into
the Fonts folder for you. You can add DAs to the Apple menu by dragging the
DA, or an alias  of the DA, into the Apple Menu Items folder , also within
the System Folder.
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See Also
Alias; Apple Menu Items folder; Desk Accessory; Font; Font Utility; System 6;
System 7

Font Distributors
See
Type Foundries and Distributors

Font Formats
The original Mac fonts were bitmapped fonts , named after cities
(remember Venice and London?). There were no outline fonts , only
bitmapped fonts, and the original Mac printers were dot-matrix, so when
these were printed  they showed the dots the letters were built from.
Bitmapped fonts only look reasonably decent when they’re used in the
specific sizes users have screen fonts for.

Adobe’s PostScript  page description language, used in laser printers,
allowed fonts to be described by their outlines, rather than in terms of a set
of dots. Each font still had a bitmapped component, called a screen font and
used only for screen display, but the outline font, also called a printer font,
was what got sent to the printer. The printer was in charge of rendering that
outline, or turning into printed dots, at the highest possible resolution.
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PostScript Type 1 fonts , as these were called, are still the standard for
desktop publishing, but they’ve been joined by fonts in other formats.

TrueType is an outline font format created by Apple; it doesn’t use PostScript
to describe outlines, but the printed results are the same—high quality,
smooth type printed at the printer’s highest resolution. There’s only one
piece to a TrueType font—the suitcase file, which contains both the screen
fonts and the outline fonts sent to the printer. This makes installation
somewhat simpler. TrueType fonts can only be used with System 6.0.5 or later.

TrueType fonts are also available for PCs, and they’ve been adopted as a de
facto standard in much of the business world. Home users also use TrueType
fonts, particularly because they don’t require a PostScript printer, as
PostScript fonts do. Desktop publishers have generally rejected the TrueType
format because it’s not entirely compatible with PostScript output devices
and because it takes longer to print.

Refinements of these two formats offer users greater type quality and the
ability to create their own custom versions of fonts.

Multiple Master fonts  from Adobe have built-in “design axes,” created by
the fonts’ designers, that allow users to make custom versions of fonts that
vary in weight, width, or other characteristics. QuickDraw GX , the print
technology Apple unveiled with System 7.5, includes a GX font format (GX
fonts can be either PostScript or TrueType) that can include much more
information than standard fonts. This will allow for more complex use of
type, including making alternative characters more accessible and

F



improving the level of kerning  and hinting .

See Also
Bitmapped Fonts; Fonts; GX Fonts; Hinting; Kerning; Multiple Master Fonts;
Outline Fonts; PostScript; Printing; QuickDraw GX; TrueType; Type 1 Fonts

Font ID Numbers
See
Font Utilities

Font, Installing
See 
Installing Fonts

Fonts, Unique Types
There are thousands of TrueType  and PostScript  fonts available. Typefaces
of every description can be had for a few dollars, and sometimes for pennies.
Not only do fonts  appear on disks and CDs, but there are fonts available on
the Web as well, sometimes for a charge and sometimes for free. Most
computer font enthusiasts receive at least six mailings a year that advertise
new font library collections, and newly designed typefaces. The temptation to
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own more than we need is always there, because fonts give emotional
character to the displayed message, no matter the medium.

It’s always a little dangerous telling someone else what fonts should be
considered for inclusion in their library, rather like proselytizing a
religious point of view. With that in mind, there are some general categories
you might consider, based upon the expectations of clients and the trends of
the design profession. First, it is vital to include both Helvetica (the most
common sans serif face) and Times (a common serif face). Times and
Helvetica come in slightly different flavors based on the type house they
come from, so the specific choices are up to you. Added to this is the necessity
of having some knowledge of other common faces, like Futura, Franklin, Dom
Casual, Palatino and others. Taken together, this is a good basic group of
representative fonts.

Next, it is suggested that you include faces that are most common (and in fact
demanded) by the software you plan to use. A specific interface is usually
designed to look its best with targeted fonts. Unless that software comes with
the fonts it needs (which is becoming less and less common), you should not
delete large numbers of fonts from your library. To do so risks having to load
the fonts again. You may be asked to reinstall them if you do. Third, include
some fonts that are outside of the common sans serif/ serif category, like a
script and brush font. Keep an eye on the design industry and on the trade
magazines to see what fonts and font families are currently being touted.
Become aware of your own tastes, your favorite fonts, and seek them out.
Fonts are as much the personality of the designer as they are utilitarian ways
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to craft a message.

Keep an eye out for novel typefaces. They can often help you distinguish
your message from that of the competition. As an example, here are a few
font families and collections worthy of investigation.

The Deniart Collections— Deniart (at 416-941-0919 in Toronto, Ontario,
Canada) offers seven font collects in the Mac and PC formats: Castles and
Shields, Egyptian Hieroglyphics (three volumes), Signals and Signs, Ancient
Writing, and Meso Americans. These are not really for use as headlines or
body copy, but as graphic embellishments, just as is the more common Zapf
Dingbats. You can, of course, use these fonts as interpretable text if your
audience is able to read the messages. Egyptian hieroglyphs, for instance,
would be very useful if your task was to write a scholarly work on Egypt, and
other Deniart fonts (Aztec Sun Signs, Morse Code, American Signing
Alphabet for the hearing impaired, Old Persian Cuneiform, to name a few)
might also serve to communicate various texts. Deniart fonts come in both
TrueType  and PostScript Type 1  on floppy disks.

Expresiv  Fonts: Brush Script Collection— World Art (One Datran Center,
Suite 1500, 9100 S. Dadeland Blvd., Miami, FL 33156) markets these TrueType
and PostScript fonts. The CD contains hundreds of brush script typefaces, and
each is unique. If you are looking for a softer approach to type, this is a CD
font collection that you should own.

Kidbag —If you’d like to expand your font library with the most novel
collection of fonts available, look no further than this offering from DS
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Design (919-319-1770). Leave the adult world behind, and write your message
with children’s crayons and other explorative media. KidArt, a collection of
kids artwork in both black and white and color in the PICT format, is included
as a bonus. KidType includes four font families that mimic the following
media: crayon, marker, paint and ruled print.

See Also
Fonts; Typography

Fontmonger
See
Font Utilities

Fontstudio
See
Font Utilities

Fontographer
When the fonts  you have just aren’t quite what you need, Fontographer can
help you create your own custom fonts.
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Starting either from scratch or from an existing font, Fontographer allows
you to modify font outlines, using Bézier curve  controls similar to those
found in PostScript  drawing programs  like Illustrator  and FreeHand .
Other drawing features include “Snap to point” and “Snap to guides,” which
simplify creating clean outlines. Once the outlines are complete, users can
draw their own bitmapped screen fonts for any size desired, or Fontographer
can create them automatically.

The program can also merge two existing fonts to come up with one that’s
somewhere in the middle (watch out—results are unpredictable), and it can
import EPS  files created in drawing programs as characters.

A common use for this sort of application is to add special characters (such as
fractions or diacritical marks) to existing fonts, or to create logo fonts that
contain all the different logos a company uses in different situations.
Another handy feature is the ability to print keyboard maps.

Fontographer works with PostScript Type 1 , Type 3, TrueType  and
Multiple Master  fonts, and it can export EPS and PICT  files for use in draw
programs.

See Also
Bézier Curves; Bitmapped Fonts; Draw Programs; EPS; FreeHand; Illustrator;
Multiple Master Fonts; Outline Fonts; PICT; PostScript; TrueType; Type 1 Fonts
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Font Substitution
If you open a document and a font  that is included in the document is not
present in your system, a number of applications have a font substitution
feature that will enable you to substitute a font of your choice to "stand in"
for the font that is missing. Some applications also have automatic font
substitution, which picks the closest matching font from your installed fonts
to match the missing fonts.

Font substitution is also very valuable when you are working with files
created on a PC. For example, if you are given a document that was created
with the Windows version of PageMaker , you can open that file with
PageMaker for Macintosh. Unfortunately, you can't be sure that you'll have
the same fonts installed on your Mac that used in their document, which was
created on a PC. That's where font substitution comes in handy, because
PageMaker will look in its built-in database  and find the installed Mac font
that most closely resembles the PC font, and offer to substitute it instead. If it
can't find a reasonable substitution, it enables you to pick a font from a pop-
up menu to substitute temporarily or permanently any time it encounters
that font, by adding that font match to the application's built-in database.

See Also
Database; Font; PageMaker
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Font Utility
There are a number of utilities  that are designed to help you work with and
better manage your fonts . Apple's own font utilities include the Key Caps
DA, which helps you find special characters within any given font, and the
Font/DA Mover , which was a necessary utility back in System 6  that you
had to use any time you wanted to install a font to your system. With System
7 and higher, you can install fonts by just dragging them into the System
folder, so this utility is no longer necessary.

There are also a number of third-party font utilities that add features to your
Mac's font management capabilities, like the capability to open sets of fonts
and to store and use fonts outside the Fonts folder. There is also a popular
shareware font utility called PopChar  that acts as a replacement for Apple's
Key Caps DA by adding a pull-down menu to your menu bar, displaying all
the special characters of the currently selected font. To choose a character to
insert, you select the special character in PopChar's display window, release
the mouse button, and that character will appear at the insertion point in
your document. Very handy.

Font management tools enable you to create sets of fonts, and add fonts from
locations other than the font folder within the System Folder. The two most
popular font management tools are Suitcase (now on version 3.0) from
Symantec (10201 Torre Ave, Cupertino, CA, 95104-2132, Phone (800) 441-7234 )
and Master Juggler from Alsoft, Inc. (P.O. Box 927, Spring, TX 77383. (713) 353-
4090)
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One of the most popular Font Utilities is Adobe Type Manager, from Adobe
System (1625 Charleston Rd. Mountain View, CA 94043.
http://www.adobe.com) which eliminates jagged type on screen and on the
printed page at any size; and makes Type 1 fonts available to any printer.

The Type Book (from Rascal Software) enables you to view samples of your
entire font collection either on screen or by printout. It displays the font in
a variety of sizes, and uses each font in a paragraph of sample text to enable
you to see the font in use.

See Also
Font; Font/DA mover; Key Caps DA

Football
See
Sports Games

Footer
A footer is a line of information placed at the foot of consecutive pages of a
document. It may contain the title, author, date, page number, and/or other
information. If you wish, you can use a different first footer for the first
page of a mullet-page document. You may also choose to create a first footer
and leave it empty, so that page numbering will begin on page two. Headers
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and footers are handled differently on various word processors. Microsoft
Word 6 sets both from a single dialog box. Nisus has separate menu items for
headers and footers, but both create them in a separate window from the
main document. MacWritePro places the header or footer directly on the page
so that you can see its position relative to the rest of the text.

Force Finder to Quit
When the Finder is the active application, -Option-Escape is used to force
the Finder to quit. This is used to enable you to rebuild your desktop
without having to restart your computer. When you use the force quit
keyboard combination, a dialog box appears asking, "Force Finder to Quit?
Unsaved changes will be lost."

To initiate a force quit, click Force Quit or click Cancel  if you don't want to
force quit. If you select Force Quit, click and hold the Option  and Command
keys, and as the Finder starts to display the desktop again (this only takes a
couple of seconds) you get a dialog box asking, "Are you sure you want to
rebuild the desktop on the disk “(your start up disk's name appears here)"?
Comments  in info windows will be lost." If you want to rebuild the desktop,
click OK, and the desktop is rebuilt on your startup disk.

Note: Any comments that you have placed in the Get Info  box of any files
are erased. In System 7.5.3, Apple has updated the system to preserve any Get
Info box comments when you rebuild the desktop.

F



To rebuild the desktop using Force Finder to Quit, follow these steps:

1. At the Finder, press Option- -Esc.

2. A dialog box asks, "Force Finder to Quit? Unsaved changes will be lost."
Click OK.

3. Hold down the Option and Command keys until you get the dialog box
that reads, "Are you sure you want to rebuild the desktop on the disk
"(your startup disk's name appears here)"? Click OK and the desktop is
rebuilt without having to restart your drive.

See Also
Cancel; Command Key; Comments Box; Finder; Get Info; Option Key; Quit;
Rebuilding the Desktop

Force Quit Command
This keystroke combination ( -Option-Esc) is used to force the current
application to quit.  This can be used if you have experienced a software
crash  while running an application and the application no longer responds
to your commands. Rather than restart the machine, often times you can
force quit the application and return to the Finder.  It is recommended that
you then restart the machine, because the situation that caused your
application to freeze may still exist, but by force quitting, you can restart
from the Special menu  properly. Force quitting also gives you an
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opportunity to save any documents that may be open in other applications
before you restart.

To force quit an application, follow these steps:

1. If the program freezes or refuses to respond to your commands, press
the -Option-Escape key sequence. You get a dialog asking, "Force
(the name of the application appears here) to Quit? Unsaved changes
will be lost.” (They were lost anyway at the point the application got
hung up.)

2. Click OK and you return to the Finder where you can Restart from the
Special menu.

See Also
Finder; Quit; Restart; Software Crash; Special Menu

Forcing Items to the Top of a List
The Mac sorts items alphabetically by name as a default. If, for example, you
put items into your Apple Menu  Items folder, they appear in alphabetical
order. When you're in an Open or Save dialog box, the items in the list
window appear in alphabetical order. However, there are instances where
you want a particular file, or group of files, to appear at the top of a list.
Many people, for example, like to keep all their aliases of applications at the
top of the Apple menu, with the less-used items at the bottom, so they force
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these application aliases to the top of the Apple menu by adding a character
to the beginning of the name of each application.

If you add a space (by pressing the space bar once) in front of the name of
an alias, for example, and put it in the Apple Menu Items folder, it appears at
the top of the list.

Apple's code for sorting items is as follows: Numbers come before letters, so
any filename starting with a number would appear before filenames with
letters. The top most item’s name would start with a space, followed by items
with names that start with: !, ", #, $, %, &, ', (, ), *, ÷, ., and /. By using these
characters at the beginning of filenames, you can group files together, or at
the top of the list, by knowing how Apple sorts items alphabetically.

See Also
Apple Menu; Naming a File

Foreign Games
See
Eastern Mind, Foul Play, Yellow Brick Road II

Foreign File Access
Foreign File Access is a System Extension used to handle non-HFS disks. HFS
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is the file system the Macintosh operating system uses. Foreign File Access
comes with several plug-ins that enable it to recognize foreign disks. The
standard plug-ins are High Sierra , ISO-9660 , and Audio CD Access . There
is also one for the QuickTake  camera called QuickTake Access.

Foreign File Access and the ISO-9660 extension are used along with the
extension Apple Photo Access  to provide support for Kodak's Photo CD -
format discs.

See Also
Audio CD Access; Apple Photo Access; HFS; PC Exchange; Photo CD; QuickTake
Access

Foreign File Access Extension
This is another standard extension installed for use with Apple CD-ROM
players. It enables the use of certain CD-ROMs in formats that were not
designed specifically for the Macintosh. It also is an important extension for
accessing audio CDs, which can also be played from Macintosh CD-ROM
players.

See Also
Apple CD Audio Player; CD-ROM; Extensions
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Foreign-Language Page Layout
Desktop publishing in languages other than English brings up some special
issues: spellchecking, assuring proper hyphenation, and using alternative
alphabets.

When the second language in question uses the Latin alphabet used by
English, users must deal with spellchecking, assuring proper hyphenation,
and using diacritical marks such as accents. These are all fairly simple issues,
since most page layout packages today include foreign-language spelling and
hyphenation dictionaries. As for special characters, most are accessible in
common fonts; a utility such as Apple’s Key Caps or Symantec’s KeyFinder
will come in handy when trying to locate these symbols, but they’re in there.

Budget and shareware fonts, however, may not include special characters, so
beware.

The really interesting problems come up when dealing with other alphabets:
Cyrillic, Arabic, Hebrew, Japanese, Chinese. Apple’s Language Kits are
intended to facilitate this process.

There are two basic elements to the Language Kits:

• Foreign-language system software

• The ability to use foreign alphabets

The Apple WorldScript extension allows your Mac to use non-Latin
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languages, both two-byte languages such as Japanese, Chinese, and Korean,
and one-byte right-to-left languages such as Arabic and Hebrew. Language
Kits also include special fonts and keyboard layouts (along with keyboard
overlays) for different alphabets.

Language Kits are available in the following versions: Japanese, Chinese
(traditional and simplified), Arabic, Hebrew, and Cyrillic.

Not all applications are WorldScript-savvy, and some have only a degree of
compatibility with WorldScript, so shop carefully. For example, Photoshop
can handle traditional Chinese characters, but not simplified ones.

Desktop publishers can use non-Latin fonts with any program, although
without Apple’s special software the right-to-left languages need to be set
left-to-right and fonts with larger character sets (primarily Asian fonts)
aren’t supported. There’s a wide variety of foreign typefaces, ranging from
those based on Latin typfaces (Minion Cyrillic, Times New Roman Greek) to
those created especially for use with other languages (Rashi, a Hebrew font,
and NewSeoul, a Korean one).

See Also
Fonts

Fork
See
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Resource

Formatting Disks
See
Disks, Initializing

Formatting Text
Formatting is the term for defining the appearance of text on a page. It
includes setting margins, defining the number and width of columns on the
page, setting indents and tab spacing, and defining the font, size, line
spacing and alignment of characters. Formatting can be accomplished in any
of several ways. You can format text from the word processor’s ruler or tool
bar, or from dialog boxes accessible under the Format menu, or by using
keyboard command shortcuts on selected text blocks.

Different word processors set margins and perform other text formatting
functions in slightly different ways. Microsoft Word 6, shown in the
following figure, sets margins in the Document Layout dialog box. To change
the margins, put new values in the windows. Columns can be defined in the
Columns dialog box, shown in figure f-2-cr, or by clicking on the toolbar’s
columns icon and selecting 1-4 columns. The latter method doesn’t give you a
choice of column width.
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Tabs and indents can be defined either by entering numbers in a dialog box,
or simply by selecting the type opf tab and clicking on the document ruler at
the place where you want to insert a tab. By default, tab stops are set every
half inch. When you define a tab, the default tabs to the left of it are
automatically cleared. To set an indent, drag the indent indicator to the place
where you want it. To change the indents or tabs in previously formatted
text, select the block of text to be changed, and then make the change on the
ruler. Text not selected will not be changed.

The Format menu (found in most word processors and DTP programs) gives
you lots of options for text formatting. The Font dialog box lets you select a
font, size, color, style (plain, bold, italic, invisible, etc.) and may give you
additional choices regarding kerning, spacing and position on the line.
SimpleText and other basic text programs may require that you choose fonts
and their attributes from a menu, rather than a dialog box or toolbar. In
general, simpler programs will give you fewer options.

Forms in HTML, Creating
Forms are a feature of HyperText Markup Language (HTML ) documents that
permit two-way communication between Web page  authors and individual
readers. Forms enable Web users to make purchases on the Internet , fill out
surveys, subscribe to publications, or submit other data to remote Web
servers .
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Forms consist of two parts, one visible ons-creen, the other invisible:

1. The visible parts are the text entry fields, buttons, and checkboxes that
an author creates with HTML commands.

2. The invisible part is the Common Gateway Interface (CGI) or
AppleScript  that processes the form data that a reader submits to a
server and presents that data in a useable form to the Webmaster.

The following table lists some of the basic HTML commands used to create
form input fields.

Common Form Tags in HTML

HTML Element Attributes Description

<FORM> </FORM> ACTION="  " Identifes URL  of script to
process form data

METHOD="  " Possible values are GET and
POST. Specifies how form input will be sent to
server.

<INPUT> TYPE="  " Values can be CHECKBOX, TEXT,
SUBMIT, RESET, IMAGE, HIDDEN.

NAME="  " Names the input item.

VALUE="  " Specifies default text or hidden
value, button label, or values of check box or
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radio button.

SIZE="  " Gives size of text field.

<TEXTAREA> </TEXTAREA> NAME="  " Name to be submitted to
gateway script.

ROWS="  "Number of rows.

COLS="  " Number of columns.

<SELECT> </SELECT> NAME="  " Name to be submitted to
gateway script.

SIZE="  " Number of items to be displayed. If a
value is given, the selection is a scrolling list.
If no value is epcified, the selection is a pop-up
menu.

<OPTION> SELECTED="  " The SELECTED item in the pop-
up or scrolling list will be selected by default.

VALUE="  " The value to submit if this list
item is selected when the form is submitted.

A guest form is created with the following HTML:

<html>

<head>
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<title>Guest Book</title>

</head>

<body>

<h4>Please sign my guest book.</h4>

Next, add the tag <FORM>. . .</FORM> to tell your browser that what should be
displayed as a form comes between the start and end tags.

<FORM METHOD="POST" ACTION=". . /cgi-bin/GuestBook">

The start tag of the <FORM> command includes two elements: the METHOD and
the ACTION. The METHOD attribute can either be GET or POST. (The end tag
</FORM> comes at the bottom of the form.) "cgi-bin" is a folder or directory
that holds the computer scripts (Common Gateway Interface (CGI) scripts that
are used to process information received from Web pages.

The ACTION attribute designates what action is to be taken when someone
submits the form—in this case, put the data in a directory called “GuestBook.”

Next, enter the INPUT tag. This specifies fields where data will be input:

<p>My name is:<INPUT NAME="guest"></p>

INPUT usually has two attributes: NAME and TYPE. NAME is the name of this
element. By default, a box will be created where the reader can enter data.

The last form element, also an INPUT element, is a standard button that
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submits information to your server:

<p><INPUT TYPE="submit"></p>

</FORM>

</body></html>

Forms, CGIs to Process Once the data is submitted it would be processed on
the receiving server by a CGI script written in PERL, AppleScript, or another
language. Some ready-made CGIs such as Forms.acgi and Email.cgi work with
the WebStar server and can be found on the Web at:
http://www.starnine.com/development/extendingwebstar.html.

The Frontier  scripting environment for the Macintosh also provide
AppleScript CGIs, some of which parse data automatically:
http://www.webedge.com/frontier/formprocessing.html.

See Also
AppleScript, CGI, HTML, Internet, URL, Web Page, Web Server

Forms and Reports, Custom
Most financial programs enable you to customize the look and content of
such common business forms as printed checks, invoices, statements,
purchase orders and mailing labels. You can add your company logo or other
art work, move fields  or change their size, change the overall size of the
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form or change the number of forms printed on a sheet of paper or label
stock. You might decide that you need additional text fields, or fewer fields
than the default format gives you. Your company may use a particular font
or style of type. You could re-design the form to fit window envelopes you
already have, or to make it more like the non-computerized ones your
customers and employees were used to working with.

Some programs make the job easier than others.

If you’re working with MYOB  (Mind Your Own Business), you can customize
your forms by telling the program to print a particular form, such as an
invoice, then clicking the Customize button at the bottom of the Forms
Selection dialog box. (For reasons known only to MYOB’s programmers, you
must ask to print the form before you can modify it.) Customize… opens a copy
of the existing format, with some (very limited) drawing tools. You can add
text boxes here, choose your type, draw vertical or horizontal lines, and place
graphics from the Clipboard.

Peachtree Accounting for Macintosh  uses a Forms Designer module
that can be reached from the Maintain… menu. You may create a new form
from scratch, or modify an existing one. The Peachtree manual warns users
to be careful when modifying forms, lest they break the links that allow the
program to place data in the fields. They advise using an existing Form
Design as a template for a new form, to maintain linked operations.

In the Peachtree system, items you put on the form, such as placeholders for
text, are called objects. There are text, data, shape, command, and paste
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objects. Data objects are linked to data fields in the program by command
objects. Text objects print a non-changing piece of text on the form, for
example “Invoice number _____.” A data object would be placed next to it,
along with a command object telling the program to, “read invoice number.”
A shape object might be a gray filled box behind the text and data objects that
make up the invoice number block. Use a paste object to import a graphic,
such as the company logo, from the Clipboard.

Reports also can be customized. The figure shows how to do it in MYOB. Use
the Reports menu to get an index of reports, and after selecting one, click the
Customize button to get the dialog box shown in the figure. Set the text in any
font and size you like and change the margins if necessary. Peachtree
doesn’t give you any graphic control over your reports, but you can choose
whether to display items by name or by number.

See Also
Financial Software; MYOB (Mind Your Own Business); Peachtree Accounting

Formula
A formula is a set of instructions in a spreadsheet cell  that tell it where to
find data and how to process it. The result is displayed in the cell, but the
formula itself is readable in the formula bar  whenever the cell is
selected .

Formulas may contain text or numeric data, cell references , mathematic
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operators , and functions . In most programs, they must begin with an
equals sign.

For example, if the formula for cell C1 is “=A1*3+B1,” it will multiply the
number in cell A1 by three, add the result to the number in cell B1, and then
display the sum in cell C1. Because either of the referenced cells can also
contain a formula, elaborate chains with one operation feeding another can
be built easily.

Order of operations  Our example does the multiplication first and then the
addition. If A1 contained 3 and B1 contained 2, the example would yield 11. If
you want to do the addition first, you can write the formula “=A1*(3+B1)” and
get an answer of 15.

Spreadsheets—and most other Mac programs—always perform math
operations in a specific order as follows:

1 Any operation in parentheses

2 Exponentiation

3 Identification of negative numbers (so that the – sign is interpreted
correctly and not as subtraction)

4 Multiplication and division

5 Addition and subtraction

6 Equality tests (such as <, >)
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If more than one operation is contained in a parenthetical set, the same rules
apply within it. Parentheses can also be nested with multiple sets of
operations to be carried out in a specific order, and the innermost set will be
evaluated first. For example, “=A1^((3+B6)*B4)” will first add 3 to the contents
of B6, then multiply that by the contents of B4, and finally raise A1 to that
power.

If you’re a non-mathematician and can’t think why anyone would ever care
about the above, you might find nesting handy to make sure that spreadsheet
string  operations come out the way you’d expect. You can’t have too many
parentheses in a formula. If you’re not sure that one is required to process
data in the order you want, put it in anyway: “=(A1*3)+B1” means the same
thing as “=A1*3+B1.”

See Also
Circular Reference; Spreadsheet Notation

Formula Bar
A formula bar is a horizontal field across the top of a spreadsheet ,
identified by a cell  reference, where you can enter numbers, text, or
formulas for that cell. The bar always displays any formula for a cell, even
though the result of that formula appears in the cell itself. You can use this
feature to see whether a cell was entered as data or a formula: select  the cell,
and the original entry will appear in the formula bar.
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Some spreadsheets enable you to enter data or a formula by typing directly
into a cell, but most require you to select a cell and then type in the formula
bar that appears. The bar always has the selected cell reference displayed on
the left, and usually has buttons marked X and √ on it: click √ to put the data
in the cell, or X to undo what you’ve typed and to restore the previous data.

To access a formula bar, click on the cell you want to change. In the figure
below, you can enter a formula in cell E52 to compute ten percent of the
amount in cell E51.

See Also
Absolute/Relative Addressing; Circular Reference; Function; Spreadsheet
Notation

Fortran
The very first high-level programming language .

Fortran, short for FORmula TRANslator, was designed to enable scientists and
engineers to solve complex mathematical problems using computers without
having to deal with assembly language . As the first high-level language,
Fortran (or FORTRAN, as it was known then) rapidly became the language of
choice for much programming.

Fortran has evolved over the years through three standard versions. The
first, known as FORTRAN 66 (or Fortran VI), was much like the original
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version developed in the 1950s. It showed its roots in the days of punchcards
by requiring strict column formatting (labels had to be in columns 1-5,
statement bodies had to be in columns 7-72, and so on). FORTRAN 66 relied
heavily on GOTO statements to control program flow rather than more
sophisticated block-structuring.

Fortran 77 built upon the foundations of FORTRAN 66 and added support for
block-style conditionals (IF-THEN-ELSE) and improved handling of input and
output and text strings. Finally, Fortran 90 further modernized the language
with the addition of powerful data structure and modular programming
features, and the standardizations of many extensions to Fortran 77. Most
modern Fortran compiler s support Fortran 77, but more are adding Fortran
90 support every day.

Throughout its history, Fortran has remained true to its roots. It is still best
suited to programs that are heavy in computation and calculation. As a result,
very little general-purpose Macintosh software is written in Fortran, but a
great deal of scientific software is.

To give you a taste of the language, this simple program displays the words
“Hello, world.” indefinitely:

C

C Hello, world.

C
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Program Hello

implicit none

logical DONE

DO while (.NOT. DONE)

write(*,10)

END DO

  10 format('Hello, world.')

END

On the Macintosh, Fortran compilers are available from Motorola, Absoft, and
Fortner Research. All three of these compilers are hosted by the MPW
environment.

Motorola
Fortran SDK (Fortran 77)
Motorola RISC Software
6501 William Cannon Dr. West
MD: OE112
Austin, TX 78735-8598
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Email: ppcinfo@risc.sps.mot.com
Fax: (512) 891-3798
Phone: (800) 347-8384 or (512) 891-2999
Web: http://www.motorola.com/SPS/PowerPC/

Absoft
Absoft F77 SDK
Absoft F90 SDK
Absoft Corporation
2781 Bond Street
Rochester Hills, MI  48309
Email: sales@absoft.com
Fax: (810) 853-0108
Phone: (810) 853-0050
Web: http://www.absoft.com

Fortner Research (formerly Language Systems)
LS FORTRAN
Fortner Research LLC
100 Carpenter Dr.
Sterling, VA  20164
Email: sales@fortner.com
Fax: (703) 689-9593
Phone: (800) 252-6479
Web: http://www.langsys.com/langsys/
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See Also
Assembly Language; Compiler; Programming Languages

Foul Play: Mystery at Awkward Manor
Foul Play from The Armchair Traveler Company, a British game company, is
the brain child of designers William Beckett and William Donelson. The
premise is much the same as that of the board game Clue. Sir John Stiffney
invites six guests to dinner. In between the arrival time of 7:40 (or 7:25 if you
pick a higher difficulty level) and 8:00 p.m., someone disposed of Sir Stiffney
and its your job to find out who. Up to six players take on the role of dinner
guests (there’s even a maid for real Clue die-hards) and take timed turns
exploring the mansion.

As you wander about looking for clues, you get the chance to ask various
guest you meet about common things like their whereabouts at the time of
their murder and what weapons they might be more likely to use if they
were going to kill someone. As in Clue, when you think you’ve got the killer,
you can make a guess. Just click the phone to dial the police and make a
guess. If you’re wrong, you lose a turn. Foul Play mixes live actors against
the beautifully filmed background of Holker Hall, a mansion in England’s
spectacular Lake District. If this game is your bag, you really don't get tired
with more than four thousand possible outcomes programmed. Foul Play
offers a fun family evening of whodunit with a lot of great multimedia
enhancements.
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See Also
Are You Afraid of the Dark?; Family Entertainment; Masterpiece Mansion;
Mortimer; Yellow Brick Road II

Foundries
See 
Type Foundries and Distributors

FPO (For Position Only)
FPO refers to the use of a proxy image in a page layout to indicate the final
position and size of a graphic. In paper mechanicals (paste-ups), an FPO
image might be nothing more than a keyline with "FPO" scrawled across it in
nonreproducing colored pencil, or it might be a rough sketch of the intended
image or even a xerox copy. The actual image, usually a halftone, is then
stripped-in during the prepress process of film assembly.

The use of FPO images is a key part of digital prepress production schemes
such as APR (Automatic Picture Replacement)  and OPI (Open
Prepress Interface).  In these output systems, high-resolution digitized
images automatically replace low-resolution images embedded in an
electronic publication file. The benefit of using FPO images when
constructing an electronic publication is that the low-resolution images
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require less storage memory and speed up processing.

See Also
Automatic Picture Replacement; Open Prepress Interface; Prepress

FPU
See 
Coprocessors, Types of

Fractal Design’s Poser
There are a number of art and animation packages that allow you to design
realistic “hard” objects (reflective spheres, cars, buildings, spaceships) that
can be wrapped with spectacular textures and animated across “other-
worldly” backgrounds, seducing us into thinking that the world is made of
only hard-edged objects. There are only a few software programs, however,
that allow us to develop organic forms, at least at prices that can be afforded
by the majority of computer artists and animators. Fractal Design’s Poser is
one such unique package.

Poser is an absolutely addicting software environment for altering and
rendering variations of the human form, and doing it in a manner that is so
easy and fun to learn that more experienced computer graphics artists will
only need about five minutes with the documentation. Beginners may need
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an hour or two. Poser was designed to minimize non-visual interfacing, so
that moving Poser models gives users a sense of engaging in a virtual 3D
world. Clicking on any part of the human forms Poser uses as models makes
the chosen elements instantly available for modification and movement.

Poser's interface has the inviting design of MetaTools’ Kai’s PowerTools ,
with 3D buttons and attenuators that have the feel of real world 3D devices.
The attenuators do different things depending upon your main selections, of
which there are four: Pose, Body, Camera, and Light .

• Pose—Sets the attenuators to taper, twist, side-side, bend, and scale any
selected element of the model that is chosen. The model responds
instantly to assume a new pose.

• Body—A global option, sets the attenuators to adjust scale, rotation, and
translation of the entire model. The model on-screen responds
instantly, allowing you to set global rotations and views.

• Camera—Enables you to use the attenuators to modify camera positions
and focal parameters.

• Light—Targets any of the three lights for adjustment of the parameters
associated with their color and position, while a visual display shows
each light’s area of influence and how the model will be colorized
accordingly.

Altering the Figures  You can select a variety of ways that the initial
Poser data sets (models) appear on-screen: Silhouette, Outline, Wireframe,
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and Flat Shaded. For those with PowerMacs, flat shading is the best option. It
allows you to see an accurate preview of appendages and light interactions as
the model is set in positions. Choosing “Depth Cued” causes elements of the
Poser model closest to the camera eye to become darker and those farther
away to become lighter (a great help when moving body parts in 3D space in
a complicated pose). Systems with less memory can choose to work with
“Bounding Box Only” figures, which change the on-screen data to a
connected system of cubic objects. Poser even allows you to see how the
measurement system called “seven heads” alters the models when “Head
Lengths” is toggled on. Even before you alter body part shapes and sizes,
Poser models can be rendered as a Man, Woman, Adolescent, Child, Toddler,
Baby, Ideal Adult, or Heroic type (male or female). Models can also be textured
with various default effects, such as lizard skin or leotards.

Rendering Options  Poser allows Guides to be added to a scene for effect:
Ground Plane, Horizon Line, and four “props” (Ball, Box, Cane, and Stairs).
You can also select a backdrop picture as part of the rendering process, or
choose any background color (great if you plan to do image compositing in
Fractal Design painter, Photoshop, or other 2D rendering software). Dots per
Inch (DPI), resolution, and image size can also be set. The rendering can be
saved as a PICT file or as a Poser data file. The two main selections are
“smooth” and “muscle,” and each can be rendered as quick or detailed.
Smooth will suffice for most needs, while muscle rendering creates
anatomically correct muscle bulges on the figures. Muscle rendering is
especially effective if you are going to paint clothing on the rendering in a
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paint package, or if the model is the Heroic type (great for comic book
illustrations).

Export Poser renderings can be saved as PICT files, DXF 3D models, or RIB
(Poser native) format. DXF files are saved with only the polygon data, so all
Poser rendering options (like muscle maps) are lost. There are advantages,
however, to exporting DXFs. You can import DXF into most 3D
rendering/animation software. DXF exports can be rendered in dedicated 3D
software (Strata Pro, Infini-D, Alias, RayDream Studio, ElectricImage, and so
on) with all of that software’s unique texture mapping capabilities,
producing human figures that shine like glass or steel. When you are saving
to the DXF format as an intermediate step for rendering in a 3D package,
pump up the polygon number in the rendering software to get rid of
polygonal faceted edges in the model (unless you want that look).

Libraries Poser has four library lists that are important to keep in mind.
The first is a listing of poses. If a specific pose is chosen from this listing, it
will hold for whatever figure type is assigned to it. As you explore your own
model poses, perhaps by altering one of the poses in the library, you can
save original posed creations. The danger here, because the software is so
much fun to use, is that you will be tempted to save hundreds of new poses a
week. That’s OK if you have the hard drive space.

The second library is dedicated to loading and saving models whose body
features have been altered. Poser allows you to choose any element of a model
and resize it, leading to interesting human and non-human characters.
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Already in the library are obese and anorexic models, and a good selection of
what appear to be alien beings. Here again, the temptation will be to alter
models and save every one.

The third and fourth library deal with the camera and Lights. Default Camera
positions allow you to snap to a screen view or to turn on telephoto or fish
eye lenses. Light library listings have default selections like “summer,”
“from Below,” and more. You can save your own Camera settings and Light
configurations to these lists.

There are dozens of Poser paintings saved to Fractal’s Web site
(http://www.fractal.com). You can expect animation capability and more
design components in the next revisions.

Fractal Painter 4.0
Fractal Painter is the most ambitious painting program available, and offers
hundreds of unique tools and effects for digital painting. Fractal Painter is
used by artists and animators throughout the world as a primary creative
collection of digital tools. The documentation is clear and concise, but the
program is so multifaceted that the documentation alone can only present
the basic possibilities. You must experience it for yourself to appreciate it.

Painting Tools  Fractal Painter utilizes all of the plug-in FX painting
options Adobe’s PhotoShop program accesses and adds the following: Fill
(allows you to fill a targeted graphic with color, with another graphic,
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gradation colors, or a patterned layer), Tonal Controls  (Correct and Adjust
Colors, Brightness/Contrast, Equalize, Negative, Posterize, imposing Printable
Colors, imposing Video Legal colors, and Posterizing using the current color
palette), Surface Controls (applying Lighting, Screen and Surface
Textures, Color Overlay, Dye Concentration, Expressing a Surface Texture,
Warping and Quick Warping), Focus  (Glass Distortion, Motion Blur,.. motion
blurs can create an infinite array of cloud-like backgrounds... Sharpen and
Soften...), Esoterica  (seven different image altering options: Marbling, Auto
Cloning, Instant Van Gogh, Blobs, Grid Paper, Growth, High Pass Filter), and
Objects  (creates Drop Shadows and Alignments).

Make Mosaic  Under the "Canvas" menu, this operator allows you to build a
mosaic tiled graphic from your original art or photo in a step by step process.
Mosaic tiles applied in Painter follow the contour of the image. This effect is
also useful for making textures that map to floors and walls in a 3D scene, as
well as creating backgrounds for title/credit text in video.

Painting Tools  Twenty-two brush varieties, five airbrushes, nine
distortion brushes, twelve special "cloner" brushes, five chalks, six masking
brushes, burn, dodge, seven famous artist brushes, nine wet brushes, ten
pens, five markers, two crayons, six pencils, fourteen erasers, and three
charcoals. All of these can be adjusted by opacity sliders and up to nineteen
separate application options.

The Image Hose This tool paints a series of images saved as "nozzle" files,
which may be either user developed and saved or tapped into from the
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extensive Painter CD-ROM libraries. A CD-ROM of dozens of natural image
nozzles is available. With the image hose nozzles, exquisite paintings of the
natural world can be created. Once completed, these digital paintings can be
processed through other media effects in Painter, resulting in pencil
sketches, oil paintings, watercolors, mosaic tiled reproductions, charcoal
drawings and more. If none of the nozzles in Painter’s library are found
suitable for a task, you can take your own sequence of images or photographs
and create unique image hoses. From time to time, Fractal Corporation
releases separate image hoze nozzle CD-ROMs packed with alternate sets of
nozzles.

A large library of textures  can be placed over/under any graphic to
produce paper, cloth and other looks, all variable by opacity. Textures
include paper grain and 3D brush strokes, and all textures can be adjusted as
to amount, shine and reflection by sliders in a full featured dialog.
manipulation of the light source as far as direction, brightness,
concentration, exposure and color is also available.

Painter has the ability to input vector graphics , like those output by
Freehand and Illustrator, translate them into raster graphics, and open them
up to all of Painter’s tools and processes. Live Picture  files can also be
imported. Painter can even create pages for the World Wide Web ,
complete with "hot spot" data that can take you to other Web sites.

Painter can help you editing and overpaint video animation files. Both
Quicktime (MAC) and AVI (Windows)  formatted animations can be
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loaded into Painter. Once in, each frame can be painted with any of the tools
mentioned above. So many effects are possible, Painter 4 can be called a post-
production FX engine. Painter has a full-featured movie creation module
that allows you to create a movie of as many frames as your memory will
support. You input the frames and toggle to each as you paint moving
graphics with any of the tools we've already covered. Objects loaded in can
appear on all frames at once. Movies can be saved as Quicktime/AVI files or
as sequential frames. Painter can help you create Clone Brush
Animations. Painters "Clone" brushes allow you to manipulate an
underlying graphic in a step-by-step process. When animated, these tools
produce color flows and distortions not possible by other graphic or
videographic methods.

Painter can also create Image Hose Nozzle Animations . Want to create
moving leaves and branches as they reveal or cover your logo? Perhaps
you'd like to use natural object growth as a segue between two animated
frame sequences. Painter fosters this and more with the Image Hose and the
dozens of nozzles, either from the on-board library of samples or from your
own saved work. Each step can be saved as a frame of an animation. Process
Animation  allows you to see a process unfold before your eyes. Painter has
a special facility that allows you to record a script of your creative
movements as they progress step by step, recording movements to a script
file. These scripts can then be played back, so that the same tools used to
create an image magically appear to duplicate the whole process in real time.
Process animations are often used to tell a story, and are effective for CD-ROM
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multimedia as well as for broadcast.

Fractal Terrain Modeler
Fractal terrain Modeler is a plug-in extension for Strata’s StudioPro
(version 1.5 and above). Once StudioPro is on screen, Fractal Terrain Modeler
is accessed by going to the Modeling menu and choosing “Fractal Terrain…”.
A rectangular surface representing the top view of the scene is presented,
along with a selection of five tool icons, the arrow selector and four elevation
placement symbols. The four elevation placement symbols represent high
mountains, low mountains, medium depressions and river channels. A global
slider at the left is used to adjust the overall exaggeration of the terrain, from
low rolling geography to high sharp mountain ranges. As a default, the
slider is set at the midpoint.

As a part of the Fractal Terrain process, a group of associated menu items are
used to fine tune the modeling. The Edit menu allows you to undo the present
operation, while a clear command clears the whole terrain grid. A “Detail”
menu listing includes Average, Good, High, Fine and Excessive as options for
applying the amount of detail that will be present in the finished model.
Average detail in the model causes polygonal surfaces to be more apparent.
On the other end, Excessive detail smoothes out the polygonal edges. Higher
detail increases rendering time. Contour settings, with a default of 1.00, can
be customized according to user input, and shape the terrain to less or more
overall contouring. Smoothness adjustments can also be customized by the
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user.

The design process in Fractal Terrain is simple. Select one of the four
elevation icons from the list and place it on the grid. If you want to move it to
another location, use the selection arrow to relocate it. Place as many
mountains, hills, depressions and rivers as desired on the grid. When you are
satisfied with the map view, use the “preview” option to see how the scene
appears as an elevation model. Select OK to place the model in the main Strata
editing window.

Once the model appears in the main editing window, you can apply any of the
Strata StudioPro operations to it allowed for any 3D object. Textures can be
dragged and dropped on the terrain, and the model can be point adjusted with
Strata’s bevy of point movement and alteration tools. Final rendering obeys
all of the standard Strata settings.

Frame Accurate
Refers to a video tape player and recorder that can accurately display video
by the frame (video is made up of a sequence of frames). These decks are
usually very expensive.

See Also
SMPTE; Time Base Corrector; NTSC; Animaq
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Frames, Creating in HTML
A feature that enables authors of World Wide Web pages  to divide a page
into separate frames within the overall “frame” of the Web browser
window. Each frame has its own URL  and behaves independently of adjacent
frames. Frames, however, can also be linked so that a mouse click a
hypertext link  in one frame can bring to screen a document in an
adjacent frame.

Frames were created by Netscape  for use in the Web browser Netscape
Navigator . Although other browsers such as Internet Explorer have begun
to recognize frames, it should be noted that many browsers will not display
frames and another alternative should be provided using other HyperText
Markup Language (HTML)  commands.

Frames can be specified using HTML, and the overall commands take the
place of the <BODY> </BODY> tags usually found in an HTML document, as
indicated:

<HTML>

<HEAD>

<TITLE> </TITLE>

<FRAMESET>

</FRAMESET>
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</HTML>

In order to create frames, an author needs to be familiar with three or four
basic HTML tags : <FRAMESET ROWS="value">, <FRAMESET COLS="value">,
<FRAME>, and <NOFRAME>.

The following table lists the tags and attributes needed to create frames.

Frames: The Basic HTML Tags

HTML Tag Description

<FRAMESET> </FRAMESET> Contains an entire set of frames or
“frameset.” Used in place of the <BODY>
tag in an HTML document that has
frames. 

<FRAMESET ROWS="n, %, *"> Specifies the height of each horizontal
row within a frameset. Height is
expressed as n, a number of pixels; %, a
percentage of the page height, or *, a
variable that lets the browser determine
size based on current size of browser
window.

<FRAMESET COLS="n, %, *"> Specifies the width of each vertical
column within a frameset.Width is
expressed as n, %, or *, as above.
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<FRAME> </FRAME> Describes the size and contents of each
frame within a frameset. 

<FRAME SRC="URL"> Specifies the URL of the document that
will be contained within the frame.

<FRAME NAME="frame_name"> Names a frame so it can be linked to
another frame and respond to
hyperlinks.

<FRAME MARGINWIDTH> Determines the size of the left and right
margins between frame border and
contents of frame.

<FRAME MARGINHEIGHT> Determines the size of the top and bottom
margins between frame border and
contents of frame.

<FRAME SCROLLING="Yes|No|auto"> Determines whether or not a frame has a
scroll bar. Auto leaves it to the browser
to determine if a scrollbar is needed.
Default=auto.

<FRAME NORESIZE> Prevents the frame borders from
turning into “handles” that can be
resized by the user. Default=NORESIZE.

<NOFRAMES> </NOFRAMES> Specifies an alternative page layout not
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using frames for non-frames-friendly
browsers.

<TARGET="window_name"> Enables a link in one frame to open in a
new window using the TARGET attribute.
The targeted window has to be named
with NAME.

Frames can bring several benefits to a Web page or Web site:

• They act as organizers, providing easy access to a site’s contents.

• Nonscolling frames called ledges remain on-screen providing
advertising value.

• They add interactivity to a site and make it reduce the need to navigate
back and forth between windows.

Steps involved in creating frames on a Web page include:

1. Map out your page. Make a rough pencil sketch of the frames you want
to add and their approximate sizes;

2. Size rsows and columns. Specify approximately how wide or how deep
you want rows and columns to be (keeping in mind that they can be
changed later). Remember that 72 pixels equals one inch.

3. Add <FRAMESET> and <FRAME> tags to specify how many frames your
page will have, and what documents will serve as contents for each
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frame. Remember to accurately specify an absolute or relative path to
the source documents for each frame.

4. Provide a <NOFRAMES> alternative. Using tables or other, more
conventional HTML, arrange the contents of your frames within the
<NOFRAMES> </NOFRAMES> tags to provide an alternative for browsers
that do not display frames.

Web page authors might also consider specifying hypertext links to
documents that open in a separate targeted window using the <TARGET>
attribute. A number of predesignated values to <TARGET> can be used. For
example, in the following HTML line,

<A HREF="info.html" TARGET="_blank">Click here</a>

the file named “info.html” will open in a new blank window when the user
clicks the words “Click here”.

See Also
Hypertext Link; HyperText Markup Language; HTML tags; Netscape; Netscape
Navigator; URL; Web Browser; World Wide Web Page

FrameMaker
While many desktop publishers have never used FrameMaker, it has a large
and devoted following among those who write and publish technical
materials. Designed to automate as much as possible of the page layout
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process, FrameMaker is not for those who are pursuing the most beautiful
pages—but it can be extremely efficient.

Billed by its publisher (originally Frame Technology, now Adobe Systems) as
an all-purpose document creation program, FrameMaker can be used as a
word processor as well as a page layout program. Its search-and-replace
capabilities are strong, and since each document opens with a text box
already in place on the page and default style sheets  already set up, it’s
easy to jump right in and start writing.

But FrameMaker is also used to compose math and science textbooks, mainly
because of its built-in equation editor . Math equations can be created and
edited right in the main document window, with a full range of symbols and
operators available to users. A floating palette shows math operations such as
radicals, integrals, and matrices, so users can point and click to set up an
equation, but a full set of keyboard shortcuts speeds up the process for the
experienced user. Typgraphically, FrameMaker’s equations aren’t
perfect—they need a lot of micropositioning—but this disadvantage is
outweighed for many users by the convenience of having the equation
editor built in.

The program also contains a powerful table editor, which offers custom
ruling and shading, straddle cells, and automatic continued lines. Automated
page layout features include running heads (text can be picked up from
anywhere in a document); automatic index, table of contents, cross-
reference, and footnote generation; inline graphic boxes that float to the top
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or bottom of a page, as specified; and automatic numbering—useful for
headings, lists, and equations.

Conditional text allows users to create multiple versions of a document by
choosing to show or hide text marked with “condition tags.” This comes in
handy for projects like catalogs with European, American, and Asian
versions.

Electronic publishers make use of FrameMaker’s hyperlink  feature, which
allows readers of an on-screen document to click on a word to move to
another document or another location in the present document. A
FrameReader utility allows users to read FrameMaker documents without
having the application. FrameMaker can also create Acrobat  and HTML
documents.

Master pages, style sheets, and tools work much the same as in other page
layout applications, albeit less smoothly. Elements of other documents
(master pages, style sheets, equation preferences, and so on) can be imported
and applied to the present document, and styles in documents collected into a
group called a book can be updated all at once. FrameMaker can also update
page numbers in a book group.

Another reason for FrameMaker’s popularity is that it’s available not only
for Mac, but also for Windows, Sun, and Unix systems. Documents created on
any of these platforms are complete compatible with the other platforms
(barring font problems and incompatible graphics formats).
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See Also
Acrobat; Equation Editor; HTML; Hyperlink; Master Pages; Page Layout
Applications; Style Sheets

Framework
In programming, a framework is a set of predefined code to “do the basics”
and upon which you can build other programs.

Most programs do many of the exact same things. For example, no matter
what a program’s purpose is, it probably has to manage menus, respond to
mouse clicks, and open and close windows. Rather than rewriting all of this
functionality for every program, you can use a framework. Frameworks
enable you to concentrate on those things that differentiate your program
from others, so that you don’t have to worry about all the things that stay the
same.

Frameworks are the scaffolding upon which you can build your own
programs.

Because this idea of reusable code that is easily extended meshes well with
object-oriented programming  techniques, many of the most popular
application frameworks are written in object-oriented languages (typically
C++). These include Symantec’s Think Class Library , Metrowerks’
PowerPlant , and the grandfather of them all, Apple’s MacApp . These
object-oriented frameworks are often called class libraries, because they use
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object classes to implement and augment the default behavior.

However, frameworks need not be object-oriented. Procedural frameworks
are often called shells, because they are the empty shell of a program. This
class includes TransSkel, Jim Trudeau’s EasyApp , and DropShell, a
framework for creating small drag-and-drop applications.

Frameworks can also be written for more specific purposes. For example,
Grant Neufeld has written an excellent framework for creating CGI (Common
Gateway Interface) applications for Macintosh Web servers, and a number of
shells have been written that focus on writing Extensions, Control Panels,
and other smaller bits of code. Apple has even created a framework targeted
exclusively at OpenDoc  parts, the OpenDoc Parts Framework  (OPF).

Programming using frameworks can take much of the “grunt work” out of
development. Interface builder s can make the job even easier. These
programs enable you to edit visually the human interface of your program.
The visual interface can then use the services of a framework to provide the
expected behavior for each type of element automatically. All you need to do
is write the parts of your program that do the real work!

See Also
EasyApp; Interface Builder; MacApp; Object-Oriented Programming;
PowerPlant; THINK Class Library
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Frankie Virus
Not a Macintosh virus, but one that infects Macintosh emulators on Atari
computers.

See Also
ANTI Virus; CDEF Virus; CODE 1 Virus; CODE 352 Virus; INIT 17 Virus; INIT 1984
Virus; INIT 29 Virus; INIT 9403 Virus; INIT-M Virus; MacMag Virus; MBDF
Virus; MDEF Virus; nVIR Virus; Scores Virus; T4 Virus; WDEF Virus; ZUC Virus

Free-Form Modeling
See
Modeling

Freedom
Freedom is a simple HyperCard  stack for people who are temporarily, or
permanently, unable to speak. It is particularly useful for persons with
neurological disorders, such as Amyotrophic Lateral Sclerosis (Lou Gehrig’s
disease), and was originally developed for a young man with ALS.

Although not as sophisticated as Talk:About , it enables the user to convey
basic wants and carry on a simple conversation by pointing and clicking the
appropriate preprogrammed phrases. Freedom uses mouse clicks and
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minimum mouse movement to enable users to type and select phrases to be
spoken. It can also be configured to work with a sip and puff switch  or
single-click switch and scanning , so that even the most severely motion-
limited user can communicate.

In the figure shown here, you see a page of phrases for ordering breakfast.
Adding new phrases is simple for users who can type or who can use a mouse
and scanning software with an on-screen keyboard. Because it’s written in
HyperCard, anyone with a copy of the HyperCard application (not the player)
can resize the buttons or add icons or pictures for a user who doesn’t read.

TIP  Freedom is shareware  and can be downloaded from many
sites, including Apple’s Disability area at:

http://www2.apple.com/disability/shareware.html.

Shareware fees go to the S. Nathaniel Woodruff Memorial Fund (c/o The
Family Center, 15 W 5th Street, Emporium PA, 15834).  Tax-deductible
donations help to finance the Toy and Resource Lending Library, which
provides a library of toys and books, as well as long-term loans of special
needs equipment—car seats and such.

Freehand
Offering professional artists the tools to create everything from complex
technical illustrations to short, design-intensive multi-page documents (like
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brochures), Freehand combines precision PostScript  drawing tools with a
plethora of other useful features.

The basics: Freehand lets users create any shape—Freehand or geometrical,
with straight lines or Bézier curves —and apply a stroke (or border) and fill
to it, in any color. The program supports CMYK  color, as well as Pantone
spot color  and other color matching systems such as Toyo  (common in
Japan).

Objects can be moved, scaled, and skewed, while grouping allows multiple
objects to be modified as a unit and layering allows objects to be easily hidden
or shown, as well as moved backwards or forwards in the drawing. Precision
is easily achievable, with numerical control over the positioning and
movement of each object. Even guides  can be placed and moved by typing in
coordinates, as well as pulling them out from rulers . Documents can consist
of one or several pages (and they can be of varying sizes).

Following in Illustrator’s  footsteps, Freehand now supports the
competition’s add-on software  as well as its own Xtras : Illustrator and
Photoshop  plug-ins  add extra features to Freehand. Its own Xtras are fairly
interesting, too, including third-party add-ons that can create bar codes,
import QuarkXPress documents, and estimate distances on maps created in
Freehand.

Freehand now lets users convert a vector image into a bitmapped  one by
rasterizing it and saving it as a PICT  file. These two capabilities can be
combined to allow users to create shapes, rasterize them, and then apply
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special effects with Photoshop filters that won’t work on Freehand’s original
vector images.

Photoshop Acquire plug-ins work, too, allowing users to scan images directly
into Freehand.

Freehand has strong text-handling features, including paragraph style
sheets  and floating palettes for changing text attributes. Text can be entered
in Freehand or imported from a word processing file, and its text box can be a
specific size or an autoexpanding box that grows larger as text is entered. An
especially nice feature brought over from page layout applications  is the
ability to paste imported images or Freehand graphics into a line of text so
that they move with the text when it’s edited.

Style sheets for graphic items are a helpful feature, allowing users to keep
elements consistent throughout one or many documents. Attributes affected
include stroke width, stroke color, and fill color. Freehand’s interface uses
several floating palettes that can be displayed, hidden, or folded up so that
only their title bars show.

See Also
Add-On Software; Bézier Curves; Bitmapped Graphics; CMYK; Drawing
Applications; Guides; Illustrator; Page Layout Applications; Photoshop; PICT;
Plug-Ins; Postscript; Rulers; Spot Color; Style Sheets; Toyo; Vector Graphics;
Xtras
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FreeStyle
FreeStyle is a low-cost, easy-to-use music sequencer  that enables you to
record and edit music. You will need an external MIDI keyboard  to work
efficiently with the software.

FreeStyle includes support for musical notation, a feature not found in all
sequencing software, but the program does not support lyrics, dynamics, or
articulation marks. Professionals must export the music file to another
program using the MIDI format, and output the music from there.

Mark of the Unicorn
Price: $200
Phone or Fax: 617 576-2760
Web: http://www.midifarm.com/midifarm/motu/freestyle.htm

Freeze
See
Crashes, System

Frequency Modulated Screening
See 

F

http://www.midifarm.com/midifarm/motu/freestyle.htm


Stochastic Screens

Frequently Asked Questions
See 
FAQ

Frontier
Frontier, a system-level scripting utility from UserLand Software, was the
first AppleEvents -based scripting system for the Mac. In the days between
the release of System 7 and the long-delayed introduction of AppleScript ,
system-level scripting on the Macintosh would have been a promise largely
unfulfilled, if not for Frontier. When Apple finally did release AppleScript, it
stole some of Frontier’s thunder. Frontier had a tough time competing with
AppleScript, especially after Apple began distributing AppleScript with the
System Software. Rather than give up in the face of such adversity, Dave
Winer, the creator or Frontier, decided to take a different approach. He re-
christened Frontier Aretha, added a handful of Internet -related features,
and began distributing it for free on the Internet.

Although Frontier and AppleScript are both scripting systems, they take
radically different approaches to the same problem. Unlike AppleScript,
Frontier runs as an application. As a result, no Extensions are needed to
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enable Frontier to do its magic, but the Frontier application must be running
for scripts to execute. In addition, Frontier is native on the Power Macintosh
and supports multiple threads, so more than one script can execute
simultaneously. Combined, these give Frontier a significant speed advantage
over AppleScript.

At the heart of Frontier is the object database, a central storage facility
shared by all Frontier scripts. At its highest level, called the root, the object
database consists of a table of objects. The objects can be scripts, variables,
word processing documents, or even other tables. This table-within-a-table
structure creates a hierarchy similar to folders on a Macintosh hard disk (see
the following figure).

Objects below the root level are specified using a dot notation similar to
Internet domain names. Thus, the active window in the previous figure is
system.verbs, and the highlighted object in that window is
system.verbs.constants.

Virtually all activity in Frontier takes place in the object database. Scripts
that are currently running and their variables reside in the database, as do
scripts that define much of Frontier’s own functionality. This makes Frontier
extremely flexible and easy to customize. In fact, you can edit Frontier’s
menus and attach scripts to any menu item. You can even add entirely new
menus.

This capability of editing menus doesn’t stop with Frontier itself. Through
menu sharing, Frontier enables you to create custom menus in applications
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written to support the menu sharing protocol, including Stuffit Deluxe,
Eudora, and Netscape.

Frontier scripts are written in UserTalk, Frontier’s own language. The
following figure shows a simple script written in UserTalk. UserTalk includes
a full complement of flow control constructs (if/then, loops, and so on) and a
rich set of verbs to control the Finder, other applications, and the Frontier
environment itself. You can use any script you’ve written just as you would a
built-in verb.

Editing UserTalk scripts is a joy in Frontier. Script editor windows are
actually outlines, so any segment of code can be collapsed as you would
collapse the subtopics of an outline. For example, the highlighted line in the
previous figure could be collapsed to hide the lines indented under it. This
feature can make the flow of a script much clearer by hiding the details
when you don’t need to see them.

As the preceding figure shows, Frontier can also accept scripts written in
AppleScript, or any other scripting language compatible with Apple’s Open
Scripting Architecture  (OSA).

Extensive information about Frontier is available on the World Wide Web at
the UserLand Web site (http://www.hotwired.com/staff/userland/). The
Aretha release of Frontier is available for download there as well.

See Also
AppleScript; CGI; Internet; Open Scripting Architecture; Scripting
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Frontmost
See 
FaceSpan

FTP
Acronym for File Transfer Protocol, a method of transferring files to and
from remote computers on the Internet . A protocol is a set of standard
settings or rules recognized by different computers connected by networks .

More data is transferred via FTP than by any other method on the Internet.
The capability to enable users to download software and transmit files is one
of the Internet’s biggest assets. FTP, therefore, is a protocol recognized by
virtually every machine connected to the Internet.

(This entry discusses File Transfer Protocol in general. A number of specific
file transfer protocols related to modems that connect to either local area
networks or the Internet are discussed in File Transfer Protocols,
Modem .)

In the Macintosh world, several FTP sites with many gigabytes of disk space
store a large number of freeware and shareware programs, along with
commercial demo versions of software and types of Macintosh-related
information. These Macintosh software archives are made available to
anyone connected to the Internet. Some of the best known are:
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mac.archive.umich.edu

sumex-aim.stanford.edu

These sites are so popular that their contents have been mirrored by other
sites around the world so users in other countries can obtain files more
quickly.

A user who wants to download files from a software archive needs an FTP
client  program such as Anarchie  or Fetch . Anarchie, for instance,
eliminates the need to search through long lists of files by letting the user
enter a keyword to search for in an Archie database. Anarchie then returns
a listing that provides full filenames and all the address information needed
to retrieve the file via FTP.

A good FTP client will allow a user to create shortcut for frequently used FTP
sites. The client will also facilitate navigation between folders in a site. Some
clients fail to present the user with complete information about a file’s name,
size, or date of creation; make sure the client you use shows the complete
information as an option.

You will come across a variety of file types  on FTP sites. Each file type can
be deduced from the three-letter extension at the end of its filename. The
most common is the extension “.hqx,” which denotes a file encoded with
BinHex so that it can be transported easily across the Net. Other common file
extensions are “.txt” for an ASCII-text file, “.sit” or “.cpt” for files
compressed with StuffIt Expander  or Compact Pro, respectively, of “.sea,”
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which is a Self-Extracting Archive that launches and expands when you
double-click on it.

Keep in mind that files with suffixes such as “.zip” or “.gz” are not Mac files
and you may not be able to do anything with them after you decode them.

See Also
Decoding/Decompressing Files; Encoding Files; File Transfer Protocols;
Modem

Full Throttle
Designed by Tim Schafer who created both Maniac Mansion games, Full
Throttle combines fluid animation with killer action. Instead of jerky
cartoons and that dreaded wait between animated sequences, Full Throttle
is seamless. You play Ben, a biker out to clear his name of a murder he didn’t
commit.

The real murderer is a corporate big shot who’s trying to get rid of you and
your motorcycle gang so he can have a monopoly on the biking industry.
Full Throttle is full of puzzles and character interaction, in the same vein as
Return to Zork . The animated  scenes are fun to watch and the overall
ambiance of the game makes you feel as if you are participating in a well-
done cartoon. LucasArts-style humor adds a light touch to the generous
amount of actionAs you play, you become quite fond of the characters in the
game and are sad to see it end. Thank goodness (and LucasArts) for a well-

F



produced game with a plot.

FullTilt! Pinball
See 
3-D Ultra Pinball, Pinball Games

Function Keys
The 15 keys that appear at the top of extended keyboards are function keys
that enable users and software developers, through use of a macro  program
such as QuickKeys to add certain commands  to each key. The first four keys
already have commands assigned to them: F1=Undo , F2=Cut , F3=Copy ,
F4=Paste , but they can be reassigned new commands. Any of these Function
keys can be assigned keystrokes with a program such as QuickKeys or any
application, such as Adobe Photoshop, that enables you to assign function
keys to commands from within the application's preferences.

See Also
Commands; Copy; Cut; Macros; Paste; Undo

Function, Spreadsheet
A function is a set of spreadsheet  operators  to perform a complex
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calculation, callable by a command that can be inserted in a formula . It can
also be non-mathematic commands to be used in formulas, including text
manipulations, lookup table  substitutions, and program-specific
operations.

Functions are built into the software, and the selection varies among
programs. But almost all functions include a variety of these handy shortcuts
to solve financial, statistical, engineering, and text problems. Most programs
have a menu or palette  arrangement to simplify picking the proper
function and adding it to a formula, but you can also type them directly into
the formula bar .

Functions require arguments , expressed in parentheses after the command.
For example, the PV function in most programs computes the present value
of an investment based on periodic payments and a specified interest rate.
It’s expressed “PV(payment,interest,term)”. To use it, substitute the three
arguments with cell  references or numbers: “=PV(A1,.08,20)” would use the
payment amount in A1, and figure the compound value after 20 annual
payments with an 8 percent annual rate.

Most functions are derived from standard formulas, so you can also calculate
PV with “=payment*(1-(1+interest)^-term)/interest,” but having it as a
function makes things a lot easier.

Text functions are similar to the string  commands in BASIC or HyperTalk ,
and let you perform operations like substituting specific characters or
deleting from the front or back of a string. Logical functions allow
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branching , and take the form “IF(condition,x,y)”: if the condition is true
the formula will execute whatever operation or function is in x; otherwise it
will execute y.

Some programs require an @ sign before a function, so they are also
sometimes called “at-functions”.

FutureBASIC
FutureBASIC is a complete integrated development environment  (IDE)
for creating Macintosh programs using the BASIC  programming language.
Traditionally, BASIC is viewed as a beginner’s language. It’s name is even an
acronym for Beginner’s All-purpose Symbolic Instruction Code. Development
environments like FutureBASIC could change that perception for good.

Unlike many versions of BASIC, FutureBASIC is a first-class Macintosh
development environment. Not only does it create compiled , stand-alone
applications, it can also be used to create code resources  such as Extensions
or plug-ins. Applications created with FutureBASIC are relatively small and
fast—comparable to programs written in C or Pascal .

The FutureBASIC IDE includes a source code editor  that supports automatic
indenting and syntax highlighting; a source-level debugger ; and a
compiler  and linker . It also includes an excellent interface builder and
code generator, “PG:PRO,” that takes much of the routine drudgery out of
creating an applications’ interface.
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Because Apple does not document the Toolbox from a BASIC perspective, it can
often be difficult to make full use of new system software features in BASIC.
Staz Software has overcome that problem by including a conversion program
that generates BASIC interfaces from the Pascal ones Apple supplies.

Although BASIC is not likely to regain the position it once had for
commercial development, programmers who want to move beyond HyperCard
or AppleScript might save themselves much of the learning curve of C or
Pascal by starting with FutureBASIC.

FutureBASIC is published by Staz Software:

Staz Software
3 Leisure Time Drive
Diamondhead, MS  39525-3215
Email: Staz@aol.com
Fax: (601) 255-7086
Phone: (601) 255-7085
Web: http://www.ids.net/~paumic/FutureBasic/

See Also
BASIC; C; Code Resource; Compiled; Compiler; Editor; Integrated Development
Environment; Linker; Pascal
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